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Predgovor

O specijalu

Autor ove male skole je
svojevremeno bio ljubitelj
tutorijala koji su izlazili u caso-
pisima u vidu serijala. Vrlo c¢esto je
bas zbog njih kupovao i pratio
neke casopise.

Posto ima iskustva sa dugackim
sagledao je i
takvih serijala:

serijalima, mane

1. Da bi zaokruzio znanje o pred-
metu tutorijala, moras da cekas
kraj serijala.

2. Moras da sakupljas sve brojeve i
¢uvas ih na jednom mestu.

3. Kad ih ¢itas, moras da otvaras
jedan po jedan broj, pa se to
dodatno iskomplikuje ako se
autor pozove na neko objas-
njenje iz prethodnih brojeva.

4. Vrednost tutorijala je mozda
veca od ostatka informacija u
casopisu, ali se i oni bacaju
zajedno sa ¢asopisom ¢im

ponestane prostora na mestima
gde se cuvaju.

Ponekad je resenje nekih pro-
blema da se stranice sa serijalom
iskinu iz casopisa i tako sacuvaju.
To nikad ne ispadne bas lepo, i ne
razlikuje se bitno bez obzira da li
to radimo sa Stampanim ili
elektronskim c¢asopisima.

Imajudi sve ove mane u vidu, autor
male Skole Scribussa 1.4 je
predlozio, a redakcija prihvatila, da
uradimo ovaj specijal. Na ovaj
nacin ¢emo ponuditi citaocima
jednog od

programa U SvOjoj

kompletan tutorijal

najboljih

kategoriji, i to ne samo medu
programima otvorenog kéda nego
uopste.

Prvi LiBRE! specijal sa malom

Skolom Scribus-a 1.4 sastavljen je
od clanaka koji su u kontinuitetu
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objavljivani od 2. do 12. broja
LiBRE! casopisa; ukupno jedanaest
nastavaka. Zahvaljujemo se svima
koji su pratili ovaj serijal. Specijal je
posvecen ponajvise njima, ali i svim
drugim citaocima koji su

rad u ovom
tekstove smo

zainteresovani za
programu. Sve
prilagodili ¢itanju u kontinuitetu,
ispravili sve eventualne greske
koje su se potkrale u originalu
ovog serijala i graficki sve malo
bolje obradili.

Sada imate mali priruc¢nik koji ce
biti zgodniji za pracenje i cuvanje u
vasoj biblioteci.

Specijal nije zamena za redovni
broj LiBRE! casopisa, on je samo

poklon redakcije nasim vernim

citaocima.
Do citanja!
LiBRE! tim
Mo¢ slobodnog
softvera ﬂ w
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1 Uvod: Stono izdavastvo

1 Uvod - Stono izdavastvo

Stono izdavastvo (engl. Desktop Publishing —
DTP) kao nova delatnost javlja se sredinom
osamdesetih godina proslog veka, tacnije 1985, i
svojom pojavom radikalno transformise rad u
izdavacko-stamparskim institucijama, ali takode
sve vise omogucava da se i pojedinci na svojim
kuénim racunarima upuste u avanturu zvanu
DTP. Pojava racunara i razvoj elektronike krajem
XX veka, inoviraju i pojednostavljuju dotadasnja
dostignuca u grafickoj proizvodnji. Novine se, u
prvom redu, odnose na obradu teksta i slike
pomocu grafic¢kih programa i uredaja.

DTP Stono izdavastvo

Autoru, ili operateru na racunaru, novom
tehnologijom je omoguceno da obavi kompletnu
pripremu teksta i slike za realizaciju (Stampu),
ukljucujudi i prelom, i da na ekranu monitora vidi
izgled kompletne stranice u kona¢nom obliku.
Tehnoloski proces (oblikovanje) vrSi se na
racunaru u specijalnom softveru za kombinovanje teksta i grafike, a sa ciljem
izrade dokumenta za Stampu na laserskom Stampacu ili Stamparskoj masini.

Stono izdavastvo je proces koji se odvija u vise faza, i u kome se koriste razlicite
vrste programskih softvera i opreme. Originalni tekst i ilustracije se obi¢no
proizvode pomod¢u programa za obradu teksta, programa za slikanje i crtanje,
opreme za skeniranje Fotografija i uredaja za digitalizaciju. Gotov proizvod se
zatim prenosi u program za uredivanje stranica, a to je softver koji vecina ljudi
smatra pravim softverom za stono izdavastvo. Za doradu delova dokumenata,
ovi programi, pored moguénosti rasporedivanja elemenata, imaju moguénost
obrade teksta i grafike. U zavrsnoj fazi, gotov dokument se Stampa na
laserskom stampacu ili, ako je potreban bolji kvalitet, na Stamparskoj opremi,
dok je u slucaju elektronskog izdavastva krajnji proizvod PDF.
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Slika 1.1 Programi za stono izdavastvo: QuarkXPress, Adobe InDesigni Scribus
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DTP podrazumeva i jak hardver i skup softver:

1. Operativni sistem,

2. Programe za obradu teksta, takozvane tekst procesore, kao sto su: MS Office
ili WordPerfect,

3. Programe za obradu slika, kao Sto su: Photoshop ili Corel Photo-paint,

4. Programe za vektorsku grafiku, kao Sto su: Corel Draw ili Adobe Ilustratori

5. Programe za prelom, kao Sto su: QuarckXPressili InDesign.

Sre¢om, postoje GNU/Linux alternative za sve ove komercijalne pakete, pa DTP
nije ostao samo privilegija profesionalaca.
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1 Uvod: Stono izdavastvo

1.1 Slobodni softver za DTP

j LibreOffice”

Nijedan od ranije navedenih
komercijalnih programa nema
svoju varijantu za operativne
sisteme otvorenog koda, kao
sto su Linuxili BSD. Obzirom na
sve vecu popularnost
operativnih sistema otvorenog
kdéda, sve je vise kvalitetnih
alternativa komercijalnim
programima. DTP kao slozena
disciplina zahteva visSe takvih
alternativa.

Kao alternativa komercijalnim
tekst procesorima preporucuje
se LibreOffice, za obradu
rasterske grafike GIMP, za

izradu vektorske grafike /nkscape i na na kraju, ali i najvazniji deo DTP-a na

slobodnom softveru, Scribus.

Scribus je najpoznatiji program za stono izdavastvo otvorenog koéda. Scribus je
multiplatformski alat dostupan za sve najcesce koriS¢éene operativne sisteme,
Mac OS X, Windows, Linuxi BSD. Koristi se za pripremu za Stampu, pripremu PDF
casopisa, ili pripremu grafickog materijala za Stampanje.

10

Adobe InDesign

Adobe Freehand

Adobe lllustrator

7

QuarkXPress

Adobe Photoshop

M

Adobe PageMaker

On je alternativa komercijalnim
programima za stono izdava-
Stvo, kao sto su:

1. Corel Ventura, prvi paket
programa za stono
izdavastvo cija prva verzija
datira jos iz 1986,

2. QuarkXPress, prvi WYSIWYG
program (What You See Is
What You Get— bukvalan
prevod na srpski Sta vidis to
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Ces i da dobijes) i

3. trenutno najpopularniji Adobe InDesign.

Neki bi rekli da je uporedivanje /nDesigna i Scribusa cak pribliznije nego
uporedivanje Photoshopa i GIMP-a. To je verovatno tako zato Sto je izlaz iz
Scribusa priblizniji po kvalitetu izlazu iz /nDesigna nego sto je to izlaz iz GIMP-a u

odnosu naizlaz iz Photoshopa.

1.2 Scribus verzija 1.4

Prvi Scribus objavljen je 2001. godine. Aktuelna verzija je 1.4.

Slika 1.2 Scribus 1.4
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1 Uvod: Stono izdavastvo

Najnovija verzija donosi:

—_—

. novi graficki interfejs zasnovan na Qt4 bibliotekama,

. lakse i preciznije rukovanje objektima,

3. podrsku za Windows metafile (WMV), Xfig (FIG), Calamus Vektor Graphic
(CVG), Macintosh PICT (PICT), Kivio Stencils (SML) i DiaShapes (SHAPE),

.omogucen je uvoz vektorskih formata SVGalii Aliz Adobe Ilustratora,

. uvedena su poboljsanja u manipulaciji tekstom i

. na kraju, ali najvaznije za ovaj tekst, je to da je u ovoj verziji poboljsani
pojednostavljen sistem pomodi, a pristup internet dokumentaciji je sada
omogucen direktno iz programa.

N

[o )0, NN

1.3 O LiBRE! maloj skoli Scribusa

Obzirom da je Scribus slobodan softver, na internetu je mogucée nacéi mnostvo
pisanih i video tutorijala za njega. Vedina tutorijala je ipak na engleskom jeziku,
pa se logicno namece potreba da se napravi jedna mala skola Scribusa na
srpskom jeziku. JosS jedan je motiv presudio u korist pravljenja ovakvog
tutorijala. Naime, primetili smo da autori koji piSu za nas c¢asopis nisu bas
upoznati sa tehnic¢kim detaljima pravljenja casopisa, pa evo prilike da se i
sadasnji i bududi autori malo upoznaju sa ovom tematikom.

Logi¢no je da ¢e mala skola biti na primeru pravljenja jednog PDF casopisa. Time
¢emo malo uprostiti tutorijal, jer ne¢éemo morati da vodimo racuna o tehnologiji
stampanja. PDF dokument ¢e biti nas konacan proizvod.

Sad smo se upoznali sa osnovnim pojmovima. U slede¢em poglavlju
upoznaéemo se sa korisnickim interfejsom Scribusa i krenuti sa konkretnim
formiranjem jednog PDF ¢asopisa.

Za znatizeljne, koji zele da saznaju nesto viSe od osnova rada u Scribus-u, evo i
par internet lokacija koje im mogu pomodi da se sami upoznaju sa ovim
programom.

Korisni linkovi:

[1] http://www.scribus.net/canvas/Scribus

[2] http://wiki.scribus.net/canvas/TutorialEN

[3] http://wiki.scribus.net/canvas/Help:TOC

[4] http://wiki.scribus.net/canvas/Your_first_PDF_form_with_Scribus
[5] http://wiki.scribus.net/canvas/Scribus_Video_Tutorials

[6] http://showmedo.com/videotutorials/series?name=NfUrduNov
[7] http://www.youtube.com/user/HumpyCreature007
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2 Interfejs'Scribusa

Slika 2.1 Interfejs Scribusa

= CELE linija padajudih menija
e linija alata

radni prozor

——— == - navigaciona linija
[Pagezto3) i XPos: 69.507 mm Y-Pos: 262819 mm | statusna lin|ja

Scribus ima klasican mono prozorski interfejs sa klasi¢cnim rasporedom elemenata.
Uocavamo 5 standardnih elemenata interfejsa:

- liniju padajucih menija, na samom vrhu prozora,
liniju alata ispod linije padajuc¢ih menija,
WYSIWYG radni prozor,

navigacionu liniju i

statusnu liniju.
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2 Interfejs Scribusa

2.1 Linija padajucih menija

Slika 2.2 Linija padajucih menija

Scribus 1.4.1.svn - [f/home/fog/ext/Projekti/LIBRE! casopisf04/text/mala skola.sla]
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Ova linija sadrzi sve alate za pravljenje, uredivanje i podesavanje dokumenta, kao i
samog programa. Ovi alati su rasporedeni u 10 padaju¢ih menija. U tabeli 2.1 (prilog
A), dati su svi alati po kategorijama.

Tabelu ne treba dodatno komentarisati. Alati su logi¢no rasporedeni, a funkcije alata
¢emo upoznati u nastavku male Skole.

2.2 Linija alata

Slika 2.3 Linija alata
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U ovoj liniji su ikonice najcesce koris¢enih alata.

Tu su alati za manipulaciju dokumentima (otvori novi, otvori postojeci, snimi, zatvori,
Stampaj, izvrsi proveru, napravi PDF), zatim standardni alati za uredivanje (Undo, Redo,
iseci, kopiraj i nalepi (engl. cut/copy/paste)), zatim alati za uvoz elemenata (tekst
okvira, okvir slike, render okvira, tabele, oblika, poligona, prave linije, krive linije, linije
nacrtane slobodnom rukom), zatim alati za uredivanje elemenata (rotiraj element,
uvecaj element, oznadi tekst, uredi tekst, povezi okvir teksta, razdvoj okvire teksta,
izmeri rastojanje, kopiraj osobine, uzmi boju sa ekrana). Na kraju linije sa alatima su
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PDF elementi forme (dodaj dugme, dodaj tekst, dodaj check box, dodaj combo box,
dodaj list box, dodaj komentar, linkuj elemente).

Vecdinu ovih alata ¢emo stalno koristiti prilikom izrade naseg projekta.

2.3 Radni prozor

Slika 2.4 Radni prozor

-1 119 20 30 |40 50 50 70 200 210 1220 230 1240 80 1290 300 1310 (-
B Mync cnoGoge NMpezentaumja Y6ynTya y ﬂnhﬂmi
GHHPYW o] tpaHidie” &Tpa] ¢ TIWMBPEI iR
LS THMOBA KOj8 oTiMEY]y el oBe™ nia- CTAYROHE
+ose. [lorahaj Huje yHucbopmucak | - Slackware Cpéuja
pasnakyje o TuMa Ao TaMa ko - Wecpopmansia rpyna GYHLE
imje o FLOSSy, pagwomvue, neow] |- WMPaTckanapivja (norvctuca
cTpauvje, wrpe, auckycwje u Install noapukaj

BA-9X50

@ A

4 EEME’@D’
2

Top: 3naraH Bacoeuh

aH
JDI Software Freedom Day - SFD) je|
roaMusa npocnasa cnoﬁnnnur

cnoboae codireepa (eHr

Fest-ose
htip://en.wikipedia.org/wiki/Linux_User_
Groupitinstallfests).

Cnousopu

Beawwunm  cnowsopn  SFDa oy
Canonical Lid., Google, Linode, Lemote,

- SrboDroid TiM
Mpensuben nporpam:

- Yaony FLOSS 30-45 muw

- ¥notpe6a cnoboaror codpTeepa y
CBAKOAHEBHOM XNBOTY 45 MiH.

- Ynotpe6a cnoBogHor codpTeepay

Linux Magazine, Ubuntu User, Linux
umpowl ceera. [an cnoong Joumal, Admin Magazine, Smarl | npeaysehnma 45 Muk.
4a ynoana ja Developer, FreeBSD, Joomial, Free |- MpeaenTauvja nonynapHix nporpama
- BHocT ca cnoﬁonnou coTBEROM. Software Foundallan Free Software 30MUH.,

ce SFD on 2004,

oo

oanre v Te roanHe SFD je oapxan 28,
agrycta y3 yvewhe 12 3ajesHuua cno

jaHor codbeepa. On Tana na cse o
09. Gpoj TMMOBA Koju y4ecTsyjy

m
et
BXTMEBHMX THMOBZ Ce CMarsyje 2010
o
n

Brioja TwmoBa Kojn yuecTayly y Manu
5

cTanko je pactao (700
vosa uz 90 aemama). 36or nocne
ua cBeTcke ekoHomcke kpnae Gpoj

mnHe. Beh 2011. roavke nonas
HOBO A0 noSorbwarka v noseharsd

Bl

MoXere|

Y
inetw y Tabenu norahaja.

OPVCHN INHK:
hitp:/

SFI

{Software Freedom International (SFi) je
HenpodMTHa  opraHm3aumja Koja  je
@BaHW4Hn oprammaatop Hawa cnoGoge!
codTeepa M NPasHO MU Koje yNpas/ba

ljama, pumMa n pady
T80M SFD-a. SFI je ycnewHo aoBuo
pcnoGoherse oA nopesa y CAL, rae je;
PerucTpoBaH, Tako fa cy noHauuje 3a!
C®A ocnoboheHe on nopesa. Ve
"Software Freedom International” je naa-|
fpaHo na 6w paanukosano opraHMaa-!

Euroy &nji sponzor
su IBM i Sun M\cmsyslems xora ja
Haxanoct kynuo Oracle.

JMaH cnoboae cocpreepa y Cpomnju

Man cnobose copteepa y Cpuin he
OBe roavke no  npeu Myt 6wl
OPraHiaosaH,

Wrchopmaunie o norabajy:
Mecra onpxasarsa: Beorpan,
‘O30NE ranepuja
Darym: Cy6ora, 15. C

- Mpesentauvje 3ajeaHnua B0MUH.

- MehycoSHo apykerse

- Hemerse auckosa (CD/DVD) ca
CNOBOAHIAM CODTBEPOM

- OcnoBopure Baw Arnpoun ypehaj
(oTKMby4aBarsa, MHCTANUparLe
“ReplicantOS” unw “CyanogenMod')

Bect y NYMOHC-y:

https:/www.lugons.org/Members/gbrank
treedom-di

. y

{Banovera Tema Ha chopymy YEyHTy
ttp://forum.ubuntu-

Datum Timei Drzave. lwjy on camor norabaja (Software Free- Bpeme: o 13400 174- 194 .org/Thread-dan-slobode-softvera-u-
28, avgust. 2004 2 MNepaznato dom Day). rbiji
10. septembar, 2005 136 &0 Okynreake YnaHoBa 3ajefHULa Y| ~
16 pambar 2008 180 » Cam pau 12:00! [Tema avckycvje Ha JIMC chopymnma:
15, sepmber 2007 206 @ http:/forum.mint-srbija.com/topic/g91-
20, soptombar, 2008 583 o Ceakn porahaj je npenywren nokaHuM BajeHuUe Koje npucyeTsyly: dart-slobodnog-softvera-u-srbiji/
19. septambar, 2008 00 0 TUMOBMMA Aa ra opranuayly. YHanpes; Mozilla Cpbuja
18. soptambar, 2010 397 w0 PernCcTROBaHN TUMOBK (183 Meceua npe! - Y6ywy Cpbuia [Tema auckycuie Ha J'\YI'GHC hopymy
17, septembar, 2011 P 7 patyma wnu panvje) aobujaly Gecnnarku Crbui htips:/#forum.lugens.org/cg
: T B fpoMT4eHM naker oa SFl-a pa 6n + Jlawyx Miart GpGuja bin/yabb2/YaBB, pl”num—1345135553/
Tagena 1. SFD . nomorao camum morahaj. SFD Wikn - Libreofis
ena 1. norabaju {hitp//wiki.softwarefreedomday.org/) - Wikimedia
NMuBPE! yaconwc o ¢ C m 20712
8
H =
T v
mm = |(Normal 2| 10000% |. /& @ O [ @| 17 v | of 26 &) | | Il Tekst S L

Page5to5 100% X-Pos: 192.855 mm Y-Pos: -2511.496 mm

Radni prozor obuhvata najvedi deo interfejsa. Karakterise ga funkcija WYSIWYG. Ovo
znaci da ¢e ono Sto vidite i uredite tako biti i u zavrSnom dokumentu, sa izuzetkom
pomocnih linija koje sluze za poravnanje, pozicioniranje i identifikaciju elemenata
dokumenta. PodeSavanje Sta ¢e od pomocnih elemenata biti prikazano u radnom
prostoru se nalazi u padaju¢em meniju View.
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2 Interfejs Scribusa

2.4 Navigaciona linija

Slika 2.5 Navigaciona i statusna linija
] g

Al [ W 5]
t | ¢|Normal | ] 100.00 % || ~ & €@ |1 |v|ofl & = EBackground ¢ .| @ | Normal Vision
(et 12] | e @ o [ @[1]v]of1 % i[meack

I | x-pos: 268.47 pt Y-Pos: 682.00 pt

Navigaciona linija prvenstveno sluzi za brzi prelazak sa strane na stranu dokumenta na
kojem radimo, ali isto tako nam podesava izgled radnog prozora.

Gledajuci ovu liniju sa leva na desno, uocavamo padajuce liste:

1. za brzi odabir glavne jedinice mere ([mm], [cm], [in], [c], [pt] ...) i
2. za brzi odabir kvaliteta prikaza svih elemenata na dokumentu bez obzira na uneti
kvalitet (high, normali low).

Da pojasnimo, brza promena jedinice mere moze da bude korisna ako, na primer, za
¢itav dokument koristimo [mm] kao osnovnu jedinicu, ali nam treba veéa kontrola
kvaliteta ilustracija u pikselima. Jednostavnim klikom i odabirom piksela za osnovnu
jedinicu mere mozemo bez vedih problema da predemo sa uredivanja teksta na
uredivanje slika i obratno; vrlo korisno.

Kvalitet prikaza elemenata je takode korisna funkcija. Proveravanje izlaznog kvaliteta
dokumenta moZemo jednostavno da obavimo postavljanjem maksimalnog kvaliteta
prikaza dokumenta, tj. High. Ako biste ostavili za stalno ovaj kvalitet prikaza, moglo bi
dodi do usporenja navigacije kroz dokument zbog generisanja kvalitetne slike, zato
nije loSe smanjiti kvalitet prikaza na Low cime ubrzavamo navigaciju i rad u
dokumentu.

Sledecih par stavki u navigacionoj liniji se odnosi na uvecanje dokumenta u radnom
prozoru. Tu je combo box sa procentom uvecanja prikaza (zoom), lupa sa minusom za
umanjenje, lupa sa jedinicom za vrac¢anje u normalni prikaz (100 [%] uvecanja) i lupa sa
plusom za uvecanje.

Sledeca grupa dugmica se odnosi na navigaciju po stranama dokumenta.

Vrlo bitan list box je onaj koji se nalazi iza navigacionih dugmica. Ovaj list box sluzi za
biranje trenutno aktivhog layera dokumenta. Kao i svi graficki programi, i Scribus
podrzava layere. To znaci da razli¢ite elemente dokumenta mozete da postavite na
drugi prozirni layer, tako da prilikom oznacavanja slike ne smetaju tekstu, ili
pozadinski elementi elementima glavnog sadrzaja, i sli¢no.

O layerima u Scribusu ¢e kasnije biti vise reci.
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Na navigacionoj liniji mozemo jos uoditi dva dugmica sa desne strane. Jedno se odnosi
na pregled izgleda kada se primeni $§ema boja. Seme boja pokusavaju da docaraju
izgled gotovog proizvoda nakon Stampe. Na ekranima se koriste RGB boje, tj. boje koje
su dobijene mesanjem 3 osnovne boje: crvene, zelene i plave. U Stamparijama se
koriste CMYK boje, tj. boje dobijene mesanjem 4 osnovne boje: cyan, magenta, zute i
crne. Sema boja pokusava ove razlike da premosti. Posto mi ne¢emo Stampati nas
¢asopis i nismo podesili Semu boja, ovo dugme nam nista ne znaci, Sta vise, ako je
aktivno moglo bi nam dati pogresnu sliku izlaznog dokumenta.

Drugo dugme je Preview Mode. Ono ukljucuje i iskljucuje rezim za pregled gotovog
dokumenta. Kada je ovo dugme aktivno, iz radnog prozora se uklanjaju sve pomoc¢ne
linije i ostaje samo prikaz gotovog izlaznog dokumenta.

Navigaciona linija je vrlo bitna za snalazenje u dokumentu, pa smo ovog puta obratili
malo viSe paznje na nju.

2.5 Statusna linija

Korisnici ne mogu da uticu na elemente u statusnoj liniji. Ona samo daje informaciju o
trenutnom polozaju kursora i o stanju funkcije automatskog snimanja dokumenata.

Sada smo se upoznali sa interfejsom Scribusai znamo gde nam je Sta. U nastavku
male Skole pocinjemo sa konkretnim radom na izradi naseg PDF ¢asopisa.
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3 Otvaranje dokumenta

3 Otvaranje dokumenta

Pre pocetka rada pozeljno je napraviti plan. Plan podrazumeva davanje
odgovora na pitanja: ,Sta zelimo napraviti?”, ,Koliko je to veliko?”, ,U kojoj
formi?”, ,Sta je konacan proizvod?” i sli¢no. Scribus je vrlo fleksibilan program i
idealan je za neodlu¢ne; dozvoli¢e vam da u bilo kojem trenutku kreiranja vaseg
dokumenta izmenite ¢ak i pocetna podesavanja. Naravno da ¢e to povudéi za
sobom manje ili vise prepravki u ve¢ izradenom dokumentu, ali se barem necete
zaglaviti zato Sto niste sve predvideli odmah na pocetku izrade dokumenta.
Kada to znate, mozete opustenije pristupiti otvaranju dokumenta, bez bojazni
da vas pogresna odluka moze kostati ponovnog rada iz pocetka.

Dobro isplaniran dokument od starta povecava produktivnost, tako da ne¢emo,
u ovom uputstvu, preskociti ovu vrlo vaznu stepenicu.

3.1 Planiranje dokumenta
Opsti plan dokumenta za ovo uputstvo glasi:

1. Zelimo da visina lista bude takva da staje cela u jedan standardni ekran od
17" i da se ne mora uvecavati da bi se citala standardna visina slova od 70do
11 pt.

2. Zelimo da se dokument moze po zelji Stampati na kuénom Stampacu na
format lista A4, ali i da se moze Stampati kao pravi ¢asopis klasicnom
stampom uz manje prilagodavanje.

3. Konacan proizvod je PDF.

Trebalo bi da je ovo dovoljno podataka za otvaranje dokumenta. Na osnovu ovih
zahteva izabra¢emo sledece:

1. Portret za polozaj lista, da bi izgledao kao standardni ¢asopis.

2. Visina lista da bude 210 [mm] (polovina A4 formata 210x297 [mm]), to znadi
da biramo A5 format da bi se mogla sStampati po dva lista na jednu A4 stranu
na kuénim stampacima.

3. Biramo dvostranu stampu.
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4. Posto nam je konacan proizvod PDF, ne moramo da dodajemo ivice za
opsecanje (u slucaju da Zelite da Stampate klasi¢an papirni ¢asopis, lako je
naknadno dodati ivice za opsecanje).

Osim plana samog izgleda, potrebno je pripremiti i sadrzaj ¢asopisa. Sadrzaj je
najbolje unapred pripremiti u programima otvorenog koéda koji su za to
najpogodniji; tekst u LibreOffice-u a ilustracije u GIMP-u ili u Inkscape-u.

3.2 Otvaranje novog dokumenta
Slika 3.1 Prozor New Document

£9 New Document

New Document | New from Template = Open Existing Document = Open Recent Document
Document Layout

D Ej [:] [:] Size: A4 8

Single Double 3- 4- Orientation: |I='ort|'ail:—‘|
Page Sided Fold Fold

width: 1595.28 pt :
Height: | 841.89 pt :
First Page is:
Margin Guides | Bleeds Options
Number of Pages: | 1
Preset Layouts: None :
. Default Unit: | Points (pt) =
Left: | 40.00 pt : -
; [] Automatic Text Frames
Right: 40.00 pt =
= ‘ x g Columns: 1
Top: | 40.00 pt = _
- Gap: 11.00 pt
Batone ‘ L = [] show Document Settings After Creation
__ Printer Margins...
("] Do not show this dialog again [ OK ] | cancel

Sad je sve spremno za pocetak rada. Sledec¢i korak je pokretanje Scribusa. Prvi
prozor koji ¢e vas docekati u Scribusu je New Document. U tom pocetnom
prozoru se podesavaju postavke novog dokumenta ili otvara neki ve¢ postojedi
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3 Otvaranje dokumenta

dokument. Za otvaranje ve¢ postojec¢ih dokumenata zaduzene su kartice:

1. Open Existing Document - Otvara prozor za pretragu tvrdog diska i oc¢ekuje da
ru¢no nadete vec postojeci Scribus dokument,
2. Open Recent Document - Otvara spisak nedavno otvaranih Scribus

dokumenata.

Slika 3.2.1i 3.2.2 Kartice Open Existing Documenti Open Recent Document

New Document ~New from Template | Open Existing Document | Open Recent Document

Lookin: [[@i/home/fog > A BEE
B computer | [ build |l ™P
# fog il Desktop il ubuntu one

il pocuments il videos

il pownloads |l virtualBox vMs

il propbox il virtualco

[l logs [ www

|l Music

[l Pictures

il Podcasts

[ public

il swatchBooker-0.7.3

|l Templates

Filename: || ]

Files of type: | Scribus 1.3.4+ Document (*.sla *.SLA *.sla.gz *.SLA.GZ *.scd *.SCD *.scd.gz *.SCD.GZ)

oK || cancel

[ Do not show this dialog again

[ Do not show this dialog again

New Document  New from Template = Open Existing Document | Open Recent Document

| /home/fog/Dropbox/LiBRE!/03/LIBRE-03-cir.sla

/home;/fog/Dropbox/LIBRE!/02/LIBRE-02-cirsla

Dropbox/LIBRE!/02/Lil latsla
/home/fog/Dropbox/LIBREI-Aca/02/LIBRE-02.01-cirsla
/home/fog/Dropbox/LiBRE!-Aca/02/LiBRE-02-cirsla

oK || cancel

Pretpostavljamo da prvi put otvarate Scribusi da joS nemate nijedan dokument,
pa ¢emo vise paznje posvetiti karticama New Documenti New from Template.

3.2.1 Kartica New from Template

Slika 3.3 Kartica New from Template

New Document |[New from Template|| Open Existing Document | Open Recent Document

All ~ @ About
Brochures

Business Cards

Cards ¥
Newsletters Blue_Orange  Bokeh

Packaging

PDF Presentations
Posters
Brochure_1

Brochure_Grid_100x210_L

Brochure_Grid_100x210_P
@ Preview

.| @ Help

[) Do not show this dialog again

oK. Cancel

Ova kartica sluzi za otvaranje
predefinisanih  dokumenata. Ve¢
postoje pedesetak definisanih nacrta
razlicitih namena. Tu su nacrti za
brosSure, posetnice, kartice, reklamna
pisma, ambalazu, PDF prezentacije i
postere. Naknadno se mogu dodati i
nacrti koje sami kreirate. Tako
osnovne postavke mozete da
sacuvate i koristite ponovo kad god
vam je to potrebno. Narocito je to
slucaj kod izdavanja mesecnog
c¢asopisa. Samo jednom postavite

osnovna podesavanja i koristite ih svaki mesec za novi broj.

20

LiBRE! specijal: Scribus 1.4



3.2.2 Kartica New Document

Prva i glavna kartica sluzi za rué¢no postavljanje osnovnih parametara
dokumenta. Mozete uoditi tri odvojene celine na tom prozoru:

- Document Layout,

- Margin guides/bleeds i
- Options.

3.2.2.1 Options

Slika 3.4 Prozor New Document - Options

Options

Number of Pages: | 1

Default Unit: | Points (pt) B

(] Automatic Text Frames
Columns: 1
Gap: 11.00 pt

(] show Document Settings After Creation

Krenu¢emo od ovog dela, posto se tu podesavaju neke opste postavke koje
uticu na druge dve celine New Document prozora. Kao prvo, postavi¢cemo da
nam otvori odmah tri strane. Zatim, da nam je osnovna jedinica merenja
milimetar (najopipljivija jedinica mere na nasim prostorima) i uklju¢i¢cemo Show
Document Settings After Creation. Ovo poslednje ¢e nam odmah po kreiranju
ove tri strane otvoriti dijalog za fino podesavanje dokumenta. Ako uklju¢imo
Automatic Text Frames, u sve tri strane ¢e se automatski kreirati tekstualni
prozor pune velicine, od margine do margine. Mi ne Zelimo da to automatski
odradimo, nego ¢emo taj tekstualni prozor naknadno ru¢no kreirati i to tamo
gde nam zaista treba.
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3 Otvaranje dokumenta

3.2.2.2 Document Layout

Slika 3.5 Prozor New Document - Document Layout

Document Layout

N T 0O Sze: [d

Single Double 3- 4 Orientation: | Portrait
Page Sided Fold Fold

1)

“»r

ﬂidth: 595.28 pt -
Height: 1 841.89 pt -
First Page is:

U ovom delu se postavlja osnovni izlaz strane i njegova dimenzija. U nasem
slucaju mi podesavamo da izlaz bude Double Sided (obostrana Stampa), A5,
Portrait, a posto smo podesili da nam je osnovna jedinica mere [mm], dimenzije
A5 formata ¢e se pojaviti u milimetrima.

3.2.2.3 Margin guides/bleeds
Slika 3.6 Prozor New Document - kartice Margin guides i Bleeds

‘ Za kraj, postavicemo vodice
Margin Guides | Bleeds margine strane. Posto smo

' namestili da je osnovna mera

[mm], i ovde ¢e biti promenjene
vrednosti u milimetrima. Za
Left: ‘ 40.00 pt - poéeFak mpiemo postaviti
= margine levo i desno (odnosno u

Preset Layouts: | None

Right: ‘ 40.00 pt = sluéa'ju dvostll'ape' §t§mpe, insvid.e,
- ® outside, spoljasnja i unutrasnja
Top: ‘40_00 pt = Sﬂ margina) po 5 [mm], a za gore i
- dole po 10 [mm] zbog zaglavlja i
Bottom: ‘40_00 pt : podnoZzja. Posto nam je krajnji
- proizvod PDF, Bleeds nas ne

[ Printer Margins... ’ interesuju. Bleeds je nad mera

lista koja se ostavlja za opsecanje
lista nakon sStampanja.

22 LiBRE! specijal: Scribus 1.4



Posto smo sve Zeljene parametre definisali, mozemo da kreiramo nase prve tri
strane klikom na OK dugme.

3.3 Document Setup
Slika 3.7 Prozor Document Setup

2 Document Setup

- Document
o |
Document Layout  Page Size
Document
@ |: Size: A5 &/
Document SFi.ngle Orientation: Portrait 8
Infermation ige Units: Millimeters (mm) I
| | __‘ Wwidth: 148.000 mm - Height: 210.000 mm =
Guides D;:I'b(lf Apply settings to: [1 all Document Pages | All Master Pages
N lge
= ~ P
= | ’T Margin Guides | Bleeds
Displa e
play 3
reset Layouts: lone s
A Fold P t Layoul: | N :
Typography | m Inside: 4.999 mm ;
Q 4 Outside: 4.999 mm - a
Fold
Tools Top: 10.001 mm N '.ﬂ
@ Bottom: 10.001 mm =
Hyphenator Printer Margins... |
ﬁ First Page is:
Right Page = Apply settings to: [} All Document Pages [ All Master Pages
Fonts
H:ﬂ & Autosave
Preflight Interval: [Bmin :
Verifier =
| Defaults || Apply | OK || cancel |

Bilo bi suvise jednostavno kada bi ovo, Sto smo do sada uradili, bilo sve sto
treba podesiti na jednom novom Sribus dokumentu. Sa druge strane, upravo to
bi bilo komplikovano jer bismo tada sve ostale postavke morali pojedinac¢no na
svakoj stranici posebno podesavati. Jednom postavljeni svi opsti parametri
dokumenta znatno povecavaju produktivnost rada na dokumentu, ai sam rad je
znatno ugodniji.

Zato je dobro odmah na pocetku rada na dokumentu postaviti sve ili skoro sve
opste parametre dokumenta. Zato smo u prethodnom dijalogu ukljucili Show
Document Settings After Creation i klikom na OK dugme, osim kreiranja stranica,
odmah se otvara prozor Document Setup.
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3 Otvaranje dokumenta

Ovaj slozeni dijalog je zaduZen za sve aspekte podesSavanja osnovnih postavki
dokumenta na koje se odnosi i dostupan je korisniku u bilo kojem trenutku rada
na tom dokumentu, a ne samo na pocetku njegovog kreiranja. Do ovog dijaloga
moze se dodi kroz padajuci meni Scribus-a

File » Document Setup

tako da nema bojazni da ¢e nam neko pogresno podesavanje smetati u daljem
radu. Uvek se moze to ispraviti i nastaviti sa radom na dokumentu. Document
Setup sadrzi podesavanja:

- Document - Dijalog isti kao New Document sa dodatkom podesavanja
autosave vremena.

- Document Information - Ovde se unose dodatne informacije o dokumentu.

- Display - Dijalog namenjen podesavanju prikaza elemenata dokumenta na
ekranu, i pomoc¢nih informacija.

- Typography - PodesSavanje tipografskih elemenata.

- Tools-Slozeni dijalog namenjen podesavanju podrazumevanih postavki
teksta, slika, oblika, poligona, linija, alata za uvecavanje (zoom) i alata za
umnozavanje i rotiranje.

- Hyphenator - PodeSavanje hifenacije teksta.

- Fonts- Omogucava izbor fontova koji ¢e biti koriS¢eni u dokumentu.

- Preflight Verifier - Podesavanje verifikatora dokumenta. Verifikator moze da
proveri sve elemente dokumenta pre pravljenja PDF-a ili pre Stampe. Koliko
stroga treba da bude provera, podesava se upravo ovde.

- PDF Export - PodeSavanje PDFizdavaca. Ovde se podesava vrsta i kvalitet
PDFizlaza dokumenta.

- Document Item Attributes - Dijalog za dodavanje atributa elementima
dokumenta.

- Table of Contents and Indexes - Dijalog za dodavanje sadrzaja dokumentu.

- Sections - Podesavanje sekcija numerisanja strana. Ovde se moze podesiti da
su stranice uvoda i indeksa dokumenta drugacije numerisane u odnosu na
stranice glavnog dela dokumenta.

- Color Management - Dijalog za podesavanje Sema boja u dokumentu. U
slucaju da je PDF krajnji proizvod, Sema boja nije potrebna, a za Stampu je
ovo veoma bitan element podesavanja dokumenta.

Document Setup je za nase potrebe po podrazumevanim vrednostima vec
prilicno dobro podesen. Napravicemo samo nekoliko intervencija koje ¢e nam
pomodi u daljem radu na dokumentu.

Jedno od korisnih pocetnih podesavanja je prethodno biranje fontova koji ¢e
biti koriS¢eni u dokumentu. Svi mi na svojim racunarima imamo mnogo fontova.
U dokumentu ¢emo koristiti najvise dve ili tri familije fontova, a ostali nam nisu
potrebni. Da bismo olaksali kasnije biranje fonta za ubaceni tekst, ovde
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mozemo da uklju¢imo samo Zeljene familije pa nam u radu ostali fontovi nece
smetati, a ujedno sprecavamo da se nezeljeni font pojavi u dokumentu.

Ako zelite hifenaciju teksta (prelamanje reci na kraju reda) to treba podesiti u
Hyphenatoru. Za nasu latinicu treba izabrati jezik Croatian. Nazalost srpskog
jezika jos nema, pa samim tim nema ni dirilicne automatske hifenacije. Osim
biranja jezika, dovoljno je jos samo ukljuciti Hyphenate Text Automatically
During Typing da bi tekst bio automatski prelomljen na kraju reda.

Sve ostalo mozemo podesavatii naknadno.

Ovim smo zavrsili otvaranje novog dokumenta. Da bismo prihvatili sve
promene, dovoljno je samo zatvoriti prozor Document Setup.

Ovo nije kraj podesavanjima novog dokumenta. Treba dodati stilove, definisati
boje, layere, vodice, kreirati master strane i jos mnogo toga, ali o tome ¢emo u
nastavku male Skole.
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4 Formatiranje stranica

4 Formatiranje stranica

Kada smo otvorili novi Scribus dokument, kreirali smo tri prazne stranice. Imali
smo u vidu da ¢asopis ima naslovnu, levu i desnu stranicu.

Naslovnu stranicu ¢emo ostaviti za kraj. Njoj ¢emo posvetiti posebnu paznju, jer
je ona ,Slag na torti”, glazura.

Odmah prelazimo na uredivanje leve i desne stranice buduéeg casopisa. Neki
delovi stranica c¢asopisa su isti i mogu se odmah urediti i primenjivati na svakoj
novoj stranici. Tu pre svega mislimo na zaglavlje i podnozZje stranice, koji sadrze
informacije o imenu rubrike, teksta koji se nalazi na toj stranici, ime casopisa,
logo casopisa, datum i broj stranice. Osim ovih informacija, zaglavlje i podnozje
stranica moze da sadrzi i graficke elemente koji fizicki odvajaju ove oblasti od
glavnog dela stranice.

Bi¢e nam potrebno malo planiranja. Moramo unapred smisliti i odluditi:

- Sta ¢e se nalaziti u zaglavlju i podnozju stranice?
- Dali ¢emo nekim grafi¢kim elementima odvajati zaglavlje i podnozje od
glavnog dela stranice?

Na osnovu ovih odluka tacno ¢emo videti Sta je od ovih elemenata identi¢no na
svakoj stranici Casopisa i koji se elementi menjaju u zavisnosti od sadrzaja
stranice. Identi¢ni elementi, kao sSto su graficki elementi odvajanja, ime
casopisa, logo, datum i broj strane, mogu da se kreiraju odmah, i naknadno
primenjuju na svaku novu stranicu. Ostale elemente koji se menjaju, kreiracemo
naknadno po potrebi, ali ¢emo im obezbediti poziciju i orijentaciju.

4.1 Master Page
Leva i desna stranica se razlikuju po polozaju elemenata, tako da moramo da

napravimo dve razli¢ite master stranice (engl. Master Page). Sta je to master
stranica? Master stranica je unapred napravljeni Sablon od identi¢nih elemenata
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stranica. Jednom pripremljena master stranica moze da se primenjuje na
neograni¢en broj novih stranica, ¢ime se obezbeduje identi¢nost stranica i
sprecavaju eventualne greske formatiranja tih elemenata koje mogu nastati
prilikom ru¢nog kopiranja. Naknadna promena izgleda master stranice se
takode odrazava na sve stranice na kojima je ta master stranica primenjena, sSto
omogucava lake popravke.

Sada ¢emo napraviti levu master stranicu na drugoj otvorenoj stranici, a zatim
na isti nacin i desnu na trecoj stranici.

Master stranica u nasem primeru ¢e sadrzati:

1. Bezier curve kao graficki element odvajanja zaglavlja i podnozja od glavnog
dela stranice.

2. Ime casopisa i datum.

3. Broj stranice.

4.1.1 Leva master stranica

4.1.1.1 Crtanje Bezier Curve

Za graficki element odvajanja izabrali smo Bezier Curve, ili na srpskom -
neprekidnu vektorsku liniju. Vektorska linija se sastoji iz ravnih segmenata i
pravilnih lukova. DefiniSe se sa viSe tacaka koje odreduju duzine pojedinih
segmenata. Ovo je ujedno, za crtanje najkomplikovaniji graficki element u
Scribusu. Ostali elementi su uglavhom definisani samo dvema tackama i
eventualno svojim posebnim osobinama; na primer, shape (predefinisan oblik)
koji je odreden unapred svojim oblikom, a veli¢ina se odreduje sa dve tacke koje
predstavljaju dijagonalu odabranog oblika.

Alat za crtanje vektorskih linija nalazi se u liniji alata :; . Kada aktiviramo taj
alat, mozemo da po¢nemo sa crtanjem. Vektorske linije se crtaju postavljanjem
tacaka koje ogranicavaju segmente. Ovde treba razlikovati ravhe segmente i
segmente koji su lukovi. Ravne segmente zapocinjemo postavljanjem pocetne
tacke prostim klikom u Zeljenoj poziciji, a lukove zapocinjemo klikom, drzanjem
levog tastera misa i razvlacenjem tangente luka. Tek kad postavimo tangentu,
mozemo da nastavimo crtanje luka Zeljene duzine. Na kraju kada zavrSimo
crtanje vektorske linije, treba pritisnuti taster ESC za prekid crtanja segmenata.

Iskoristicemo margine kao vodece linije za nasu vektorsku liniju. Crtacemo liniju

sa tri segmenta: vertikalnu pravu liniju, luk u uglu margine i horizontalnu ravnu
liniju do kraja margine (Slika 4.1).
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Slika 4.1 Crtanje Bezier Curve
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Napomena: Ako tacke neée automatski da se lepe za marginu, treba proveriti
da li je u padaju¢em meniju Page » Snap markiran to Guide.

Verovatno prvi put necete uspeti da nacrtate Zeljenu liniju, a naroc¢ito mogu biti
problematic¢ni lukovi. Nista za to, ¢ak i kad vidite da je luk iscrtan naopako,
nemojte prekidati crtanje, nego nastavite dalje. Kada zavrsite sa crtanjem cele
linije, vrati¢ete se u uredivac i popraviti sve nedostatke linije.

Za ispravke vektorske linije potrebno je odabrati liniju i otvoriti Properties
prozor (F2). U ovom prozoru treba odabrati Shape » Edit... i otvorié¢e se uredivac
grafickih elemenata Scribusa (Slika 4.2).
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Slika 4.2 Uredivac grafickih elemenata

Nodes
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| Absolute Coordinates

X-Pos: | 0.000 mm
Y-Pos: | 7.190 mm
(") Edit Contour Line

Reset Contour Line

[ End Editing

Uredivac je veoma logican, pa c¢ete lako shvatiti
za Sta je zaduzen svaki pojedinacni alat u njemu.
Ovog puta ¢emo obratiti paznju na dugme Move
node | % | i Move Control Points | %

Nodes ili ¢vorista su tacke koje dele segmente
vektorske linije i plave su boje. Kada je ovaj alat
aktiviran, mozete miSem pomerati ta c¢vorista.
Control Points su roze (pink) tacke koje
kontroliSu, u ovom slucaju, oblik i usmeravanje
luka. Kada je aktiviran alat Move Control Points,
misem mozete da pomerate kontrolne tacke i
time uticete na oblik i radijus luka.

Kada budete zadovoljni korekcijom vektorske
linije, pritisnite dugme End Editing i promene ¢e
biti prihvacene, a uredivac zatvoren.

4.1.1.2 Text Framei Guides

Posto smo nacrtali liniju odvajanja, treba da postavimo ime casopisa. Ovaj deo
je cist tekst. Sve tekstove u Scribusu unosimo iskljuc¢ivo u Text Frame (tekstualni
okuvir). Alat za tekstualni okvir se nalazi u liniji alata 5 .

Da bismo lepo centrirali tekstualni okvir, upotrebi¢emo Guides. Guides su
vodecée pomocne linije i lako su dostupne u svakom trenutku. Dovoljno ih je
samo miSem prevudi sa linije glavhog prozora Scribusa i postaviti na zeljeno
mesto na stranici (Slika 4.3). Vertikalne vodece linije ,uzmite” sa levog
vertikalnog lenjira, a horizontalne sa gornjeg horizontalnog lenjira.
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Slika 4.3 Vodece linije (Guides)

Kada uokvirite Zeljenu poziciju vodedim linijama, mozete da aktivirate alat za
crtanje tekstualnog okvira i postavite okvir u Zeljenu poziciju. Ostalo je samo da
dva puta kliknete na taj tekst okvir i upiSete ime ¢asopisa.

Formatiranje teksta je tema za
slede¢i nastavak Male skole, ali

X, Y. Z ipak ¢emo ovde navesti jedan
Shape od nacina formatiranja teksta
= da ne bismo ostavili temu
Group nedovrsenu.
Text Obelezite ponovo tekstualni
okvir i pozovite Properties sa
| Tr SF TransRobotics -J F2. U Properties idite na karticu
| Oblique 5 Text, (Slika 4.4). Odaberite
_ zeljeni font, veli¢inu slova i
T | 10.00 pt - poravnanje. Na slici 4.4 vidite
= Fixed Linespacing 2)|10.00pt |2 da smo - odabral-|v font SF
TransRobotic  (zvani¢ni  font
LJL@JL@J@L@ LIBRE! casopisa), stil oblique,
> Color & Effects velicinu slova 10 [pt] i
> Style Settings poravnanje .desno za levu
> First Line Offset master stranicu.
> Columns & Text Distances
» Optical Margins
> Advanced Settings
Slika 4.4 Properties-Text
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4.1.1.3 Broj stranice

Broj stranice je promenljiv element, ali Scribus ima moguénost da automatski
umece broj stranice na unapred predvideno mesto pa taj element postaje
stati¢an i njegova pozicija se moze odmah definisati u master stranici. Za to nam
je potreban joS jedan tekstualni okvir tacno ispod linije odvajanja. Kada ucrtate
tekstualni okvir, ponovo dvokliknite na tekstualni okvir i iz padaju¢eg menija

.....

CTRL+ALT+SHIFT+P.

Ostalo je da se ponovo formatira umetnuti broj strane pomodu prozora
Properties » Text i leva master stranica je gotova.

Na kraju bi trebalo joS da snimimo ovu master stranicu. U padaju¢em meniju
odaberemo Page » Convert to Master Page... i otvorié¢e se novi prozor (Slika 4.5).
Unesite ime nove master stranice, izaberite da se ova stranica odnosi na Left
Page i klikom na OK zavrsite snimanje master stranice. Na prvi pogled se nista
nije promenilo, ali zapravo mi sada imamo novu master stranicu, Sto mozete
proveriti u padaju¢em meniju Edit » Master Pages....

Slika 4.5 Konvertovanje stranice u Master page

Convert Page to Master Page @

Name: [Leva stranica| ]

Left Page =
Copy Applied Master Page Items

Cancel OK

Za kraj: U nastavku je ostalo da sami na isti nac¢in napravite desnu master
stanicu. Ove master stanice primeni¢emo na novim stranicama koje budemo
otvarali.

Sada smo sve pripremili za dodavanje glavnog sadrzaja. U sledeéim poglavljima
pozabavi¢emo se slojevima (layers), tekstualnim okvirima i stilovima.
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5 Priprema stranica za unos teksta

U proslom poglavlju kreirali smo i sacuvali master stranice za levu i desnu
stranicu naseg PDF casopisa. Sada idemo korak dalje i primenjujemo ove master
stranice na postojece, vec otvorene, drugu i trec¢u stranicu, a posle ¢emo ih
primeniti i na sve nove stranice koje budemo kreirali.

Sa druge i trece stranice obrisa¢cemo vektorsku liniju koju smo nacrtali sa ciljem
kreiranja master stranice, i obrisa¢emo tekst i broj stranice iz podnozja stranice.
Umesto toga, primeni¢emo snimljenu master stranicu i to levu na levoj stranici a
desnu na desnoj stranici.

Najjednostavniji nacin za primenu master stranice na stranici je klik desnim
tasterom misa na stranicu i odabir iz dijaloga Apply Master Page.... U dijalogu
biramo zZeljenu master stranicu i metu primene. Kao meta moze se izabrati
trenutno aktivna stranica, sve neparne stranice, sve parne stranice ili od jedne
do druge stranice. Jednostavnim odabirom master stranice (leve ili desne koju
smo kreirali), izborom Current page (trenutne aktivne stranice) i klikom na
dugme OK, primeni¢emo master stranicu na stranice, prvo na stranici 2 a zatim
na isti nacin i na stranici 3.

Slika 5.1 Primena Master page na postojecu stranicu

Apply Maste- P~~~

Desna stranica Doda¢emo sada i dve nove stranice (4 i

Master Page: W 5), i odmah pri otvaranju _pri'r.nenit!
Normal LeFt master stranice. Idemo na padajuéi meni

Normal Right Page » Insert i otvorice se novi dijalog. U
i tom dijalogu prvo treba upisati koliko
stranica zelimo da otvorimo (u nasem
slucaju dve). Posle toga upisemo gde
zelimo da otvorimo nove stranice.
) All Pages Opcije su pre trenutno aktivne
to [55 stranice (before Page), posle trenutno
aktivne stranice (after Page) ili na kraju

dokumenta (at End). Mi ¢emo izabrati
da se otvore na kraju dokumenta. Sada

Apply to
@® Current Pag
) Even Pages

) Odd Pages

oK

Cancel |
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nas jos zanima da na tim stranicama primenimo master stranice, pa ¢emo
odabrati nase kreirane master stranice - levu za leve stranice i desnu za desne
stranice. Pored ovog, postoji mogucénost da te stranice promene format, ali to
nas ne zanima, posto Zelimo u celom dokumentu da imamo isti format stranica,
pa ¢emo samo kliknuti na OK da bismo kreirali nase nove stranice.

Slika 5.2 Primena Master page na novootvorene stranice

Insert Page -
Insert 2 - Page(s)
| at End &
Master Pages
Left Page | Leva stranica &
Right Page | Desna skranica |
Page Size
Size: | AS &
Orientation: | Portrait &
width: Height:
[ Move Objects with their Page
{ oK I | Cancel |

Primeti¢emo da je izgled stranica 2 i 3 sada isti kao i pre brisanja onih elemenata
koji su usli u sastav master stranice, ali sa tom razlikom da im je sada nemoguce
pristupiti i ponovo ih editovati. To je zato Sto se master stranica ponasa kao
specijalan layer. Najpre ¢emo pojasniti pojam layera. U grafickim programima,
layer oznacava sloj nekog crteza. Najcesé¢e se tumaci i poredi sa prozirnim
folijama koje postavljamo na crtez i zatim crtamo po njima. Svaka folija se
ureduje za sebe, ali se uvek, osim ako drugacije ne naredimo, vide sve folije, i to
u redosledu po nivoima koje smo odredili. Naravho da gornji layeri imaju
prioritet i elementi grafike iz gornjih layera zaklanjaju elemente u donjim
layerima pa se mora voditi racuna o njihovom rasporedu. U Scribusu, kao i u svim
drugim grafickim programima, po otvaranju novog dokumenta kreiran je samo
jedan layer, on se u Scribusu zove Background i vidljiv je u navigacionoj liniji.
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5 Priprema stranica za unos teksta

Master stranica se ponasa kao layer koji se nalazi ispod prozirnog Background
layera. Jedina razlika u odnosu na obican layer je ta Sto se ne pojavljuje u
padaju¢em izboru layera na navigacionoj liniji. Jedini nacin da se pristupi master
stranici i na njoj nesto izmeni je da se otvori editor master stranice. To se postize
odabirom iz padajuc¢eg menija Edit » Master Pages....

5.1 Postavljanje glavnog tekstualnog okvira na
stranicu

Svaka knjiga, brosura i casopis imaju svoju formu stranice, a u njoj dominira
tekstualni okvir. Svi ostali elementi su podredeni tekstu. Postoje razlicite
metode slaganja teksta na stranici. U knjigama dominira tekst u jednoj
monolitnoj koloni. Za razliku od knjiga, casopisi obi¢no tekst slazu u vise uzih
kolona, jer po nekim istrazivanjima to doprinosi brzem citanju. Kolone u
casopisu su toliko Siroke da oko moze jednim pogledom da obuhvati ceo red
bez pomeranja o¢ne jabucdice, tako da citalac ¢asopisa nesvesno samo pomera
pogled u pravcu gore-dole i tako dobija na brzini ¢itanja.

Ovo je glavni razlog zbog kojeg i nas ¢asopis treba da ima dve kolone, iako je A5
relativno uzan format. Tekstualni okvir ¢e i u nasem casopisu biti dominantan
element i obuhvatace citav prostor u glavhom delu stranice koji je ogranicen
marginama. Imamo samo jedan problem, a to je da smo po liniji margine nacrtali
vektorsku liniju razdvajanja. Zbog toga ¢emo morati da napravimo dve vodice
koje ¢e odvojiti tekstualni okvir za po cetiri milimetra od linija razdvajanja. Da ne
bismo imali mnogo vodecih linija koje bi nam posle smetale, pravicemo razlicite
vodece linije za leve stranice i posebno za desne stranice. Koristi¢emo osobinu
master stranice da se vodece linije tamo kreirane pojavljuju i budu aktivne
takode na svim stranicama na kojima je ta master stranica primenjena. To znaci
da mozemo nasu levu master stranicu da dopunimo vodedim linijama koje su
tacno odmaknute od vektorskih linija za 4 [mm], to jeste vertikalno na poziciji 8
[mm] (4 [mm] do margine + 4 [mm] odvajanja) i horizontalno na poziciji 17 [mm)]
(13 [mm] do margine + 4 [mm] odvajanja). Desnu master stranicu dopunjavamo
vodedim linijama vertikalno na poziciji 140 [mm] (148 [mm] Sirina A5 — 4 [mm]
do margine — 4 [mm] odvajanja) i horizontalno na poziciji 17 [mm] (13 [mm] do
margine + 4 [mm] odvajanja).

Da se podsetimo jos jednom celog postupka:

1. otvorimo editor master stranice (Edit » Master Page... > leva (desna) stranica)
2. otvorimo editor vode¢ih linija (Page » Manage Guides...)
3. dodajemo (dugme Add) horizontalne vodice na 177 [mm] i vertikalne na 8
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[mm] (leva master stranica) odnosno 140 [mm] (desna master stranica).

Scribus 1.4.1.svn - [/media/Radni/Dropbox/LiBRE!/06/LIBRE-06.5la*]
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4. Za zavrsetak samo zatvorimo dijalog Manage Guides, i na kraju i dijalog
Master Pages.

Primeti¢ete da su se vodece linije pojavile na svim stranicama na kojima su
master stranice primenjene. Sad je jednostavno postavljati tekstualne okvire
unutar postavljenih vodica sa jedne strane i margina sa druge strane. Uradi¢emo
sadai to.

Pre nego sto kreiramo nas tekstualni okvir, napravi¢cemo jedan novi layer samo
za to. To je dobro jer onda Background layer mozemo da koristimo za kreiranje
pozadina ispod ubacenog teksta i druge slicne efekte. Dijalog za kreiranje layera
je u padaju¢em meniju Windows > Layers ili jednostavno F6. Jednostavnim
klikom na ,,+” dodaje se novi layer sa imenom ,,New Layer 1”. Dvoklikom na ime
layera dobijamo moguénost da promenimo ime, i mi ¢éemo ga promeniti u
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5 Priprema stranica za unos teksta

.Tekst”. Ovde se vrse i fina podesSavanja osobina layera. Jednostavnim
potvrdivanjem polja mozete podesiti da layer bude vidljiv ili ne, da bude
stampan ili ne, mozZete ga zakljucati da ne biste slucajno napravili nezeljene
promene na njemu, mozZete podesiti da tekst iz nizih layera ,pluta” oko
elemenata iz tog layera (narocito korisno ako layersadrzi slike ili tabele, onda ¢e
tekstovi iz nizih layera okruzivati ove elemente i nece biti pokriven) i na kraju,
jedna specificna osobina da
elementi iz tog layera budu

Blend Mode:| Normal : |Opacity: | 100 % jasno o ceni obOJenv(?m
e — | okvirnom linijom  (narodito

= 50 E Name korisno ako su u pitanju linkovi,

— — koji se prikazuju kao okvir

Wy o New Layer 1 oblasti u kojima su aktivni. Kao
M & & & [ Background takvi nisu previse uodljivi, ali

ako je ova opcija potvrdena,
ovaj okvir ¢e biti oznacen jasno
upadljivom bojom). Sada
mozemo da zatvorimo dijalog
Layers i krenemo sa kreiranjem
tekstualnog okvira.

Slika 5.3 Prozor Layer - kreiranje novog layera

Proverimo u navigacionoj liniji da li je ,Tekst” layer aktivan, biramo alat za
tekstualni okvir iz linije alata i jednostavno klikom (levi taster misa) u preseku
postavljenih vodica (gornji levi ugao na levoj stranici), razvlacenjem (drzanje
tastera misa) do ugla margina (donji desni ugao na levoj stranici) i pustanja
tastera misa, kreiramo novi tekstualni okvir.

5.2 Podesavanje tekstualnog okvira

Da bi nas tekst stao u dve kolone, potrebno je urediti kreirani tekstualni okuvir.
To se radi pomocu Properties dijaloga koji smo koristili i u proslom nastavku
male skole. Tada smo ga koristili za formatiranje teksta, a sada ¢emo da
primenimo njegove opcije Text » Columns » Text Distances. Tu ¢emo odabrati 2 za
broj kolona i 5 [mm] razmaka izmedu kolona (Gap). Ostala podesavanja
odvajanja teksta od ivica nam za sada nisu interesantna, pa ¢emo ih ostaviti na
0. Sva podesavanja u Properties dijalogu se odmah primenjuju, pa ne postoji
posebno dugme za prihvatanje promena. Nakon zavrSetka podesavanja ¢emo
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samo zatvoriti dijalog kako nam ne bi
smetao.

Jednom napravljeni tekstualni okvir
mozemo da kopiramo na sve otvorene
stranice. Najjednostavnije je da se to
uradi copy/paste metodom; oznacimo
tekstualni okvir i kopiramo ga u clipboard
(CTRL+C), a zatim ozna¢éimo novu
stranicu i nalepimo (CTRL+V). Na desnim
stranicama tekstualni okvir ¢e Dbiti
pomeren u desno za 4 [mm], pa ih treba
prosto pomeriti u predvidenu poziciju
jednostavnim hvatanjem (miSem) okvira i
pomeranjem.

Ovo je trenutak kada bi trebalo prvi put
da sacuvamo nasS rad kao Template
(Sablon). Pretpostavljamo da ¢emo
ovakvu organizaciju casopisa koristiti za
svaki naredni broj ¢asopisa, tako da nam
odgovara da je bez sadrzaja. Ovakav
Sablon nije kompletan i nedostaje mu jos
layera, predefinisanih boja, stilova,
naslovna stranica i mnogo cega drugog,
ali to mozemo i naknadno dodati u ovaj
Sablon i snimiti ponovo. Snimi¢emo ovu
verziju sa File » Save as Template.... U
otvorenom dijalogu, osim imena Sablona,
treba odabrati i kategoriju (u nasem
slucaju Magazine), i potvrditi da zapamti
primenjene fontove (/nclude Fonts).
Podrazumevano, Sablon ¢e biti snimljen u
fascikli ~/.scribus/templates, i to ne¢emo
menjati.

Slika 5.4 Prozor Properties - Text -

Columns & Text Distances
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6 Unos teksta u Scribus

U prethodnim poglavljima smo sve pripremili za ubacivanje teksta u nas c¢asopis,
sada ¢emo objasniti nekoliko nacina da ubacite vas tekst u Scribus. Koliko je
bitna ova operacija, govori i ¢injenica da postoji osam nacina da se tekst ubaci u
tekst okvir. Tri su osnovna nacina:

1. ru¢no - direktno u tekstualni okvir,
2.rucno - preko internog tekst editora i
3. uvozom iz spoljnjih izvora

6.1 Rﬂépo ubacivanje teksta direktno u tekstualni
okvir

Ovo je najjednostavniji nac¢in ubacivanja teksta u tekstualni okvir, ali ne i
najlaksi. Dovoljan je dvoklik na tekstualni okvir da bi se dobio tekst identifikator
(prompt), i da bi bilo omoguceno da se u tekst okvir moze kucati tekst pomocu
tastature. Takode je moguce tekst preneti iz nekog drugog izvora ili iz
priviemenog memorijskog prostora (copy/paste operacija). Kada smo rekli da je
ovo najjednostavniji ali ne i najlaksi nacin, to se prevashodno odnosilo na
kucanje i Formatiranje unetog teksta. Jedini nac¢in da se formatira tekst u toku
ovakvog kucanja je pomocu ve¢ pomenutog Properties (F2) plivaju¢eg prozora i
njegove sekcije Text. Izmene u formatiranju su odmah vidljive, a moguce je
izvesti sve potrebne radnje na formatiranju teksta: izbor fonta, vrsta fonta,
veli¢ina fonta, veli¢ina proreda, boja teksta, dekoracija teksta, stil teksta, stil
paragrafaisl.
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Slika 6.1 Ruc¢no kucanje teksta direktno u tekst okvir
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Prakti¢no, za neke manje stvari dovoljan je i samo ovaj nacin ubacivanja teksta.

6.2 Ubacivanje teksta ru¢no preko internog tekst
editora

Interni tekst editor je dostupan kada je aktivan neki od tekstualnih okvira, i
poziva se na vise nacina:

1. CTRL+T

2.1z padaju¢eg menija Edit >Text edit...

3. Desnim klikom na tekst okvir i iz plivaju¢eg menija Edit text...

4. Preko ikonice Edit textiz linije sa alatima.
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Sama dcinjenica da postoji 4 nacina pozivanja ovog editora ukazuje na vaznost
ovog alata. Tekst editor je plivajuéi prozor Scribusa i nije tipa ,Sto vidis to ¢es i
da dobijes”. Za to postoje alati koji vrse razmenu teksta izmedu tekst editora i
tekst okvira na koji se odnosi, a pri tome se ne zatvara editor, Sto umanjuje taj
nedostatak. Na slici 6.2 se vidi da editor ima izgled naprednih klasi¢nih tekst
editora sa mnogo alata za formatiranje teksta. Ono sSto razlikuje ovaj editor u
odnosu na druge tekst editore je leva kolona koja daje informacije o
formatiranju svakog paragrafa teksta. Ovo je jedino mesto gde mozemo jednim
pogledom da se informisemo o stilovima koji su primenjeni na svaki paragraf
unetog teksta, pa ako nesto nije u redu, ovde je najlakse utvrditi Sta nije u redu i
popraviti to.

Slika 6.2 Tekst editor

e Story Editor - Text35 - + x
File Edit Insert Settings

I EBBvRB - &
||[ 7 Freesans Medium — =][10.00 pt  ={T[100.00 % ={IT[100.00 % || E|EIEE Elfno style &
| w | = #| k| «|eo]s.|AY¥ 0.00 % j|JJL,f>|B|ack |l 100 %,|JJn<§|B|ack ~| 100 %,

No Stvle lLorem ipsum dolor sit amet, consectetuer adipiscing elit. Ut a sapien. Aliquam
aliguet purus molestie dolor. Integer quis eros ut erat posuere dictum. Curabitur
dignissim. Integer orci. Fusce vulputate lacus at ipsum. Quisque in libero nec mi
laoreet volutpat. Aliqguam eros pede, scelerisque quis, tristique cursus, placerat
convallis, velit. Nam condimentum. Nulla ut mauris. Curabitur adipiscing, mauris non
dictum aliquam, arcu risus dapibus diam, nec sollicitudin quam erat quis ligula.
Aenean massa nulla, volutpat eu, accumsan et, fringilla eget, odio. Nulla placerat
porta justo. Nulla vitae turpis. Praesent lacus.

No Stvle Suspendisse potenti. Cras ut mi sit amet quam consequat consequat. Aenean ut
lectus. Cym sociis natoque penatibus et magnis dis parturient montes, nascetur
ridiculus Witus. Suspendisse vel sapien. Nullam non turpis. Pellentesque elementum
pharetra ligula. In rhoncus. Aliquam vel enim consequat sem aliquet hendrerit.
Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Nam Felis.

No Stvle Suspendisse nibh. Nunc vulputate leo id urna. Donec dictum. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit. Lorem ipsum dolor sit amet, consectetuer
adipiscing elit. Suspendisse dictum, magna consectetuer hendrerit volutpat, sapien
felis fFaucibus justo, ac dictum lacus pede in metus. Nam commodo. Sed consequat, - |

Totals:
Paragraphs: 5 Words: 449 Chars: 3119 .

Current Paragraph:
Words: 90 Chars: 622

U ovom poglavlju ¢éemo preskociti pricu o Formatiranju, a koncentrisacemo se
samo na dodavanje teksta i na razmenu teksta izmedu tekst editora i tekst
okvira. Tekst se u editor moze uneti na 3 nacina:

1. ru¢nim kucanjem teksta,
2. ubacivanjem iz privremenog memorijskog prostora (copy/paste operacija) i
3. uvozom iz eksterne tekst datoteke.
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Prva dva nacina su jasna sama po sebi. Objasni¢emo samo tredi nacin, i to kroz
objasnjenje linije za manipulaciju sadrzajem (slika 6.3).

Slika 6.3 Alati za manipulaciju sadrzajem

IOEEVD - &

Ova linija sadrzi 8 alata:

1. Clear all text - brise kompletan tekst iz editora.

2. Load from file - ucitava tekst iz eksterne 7XT datoteke.

3. Save to file - snima sadrzaj editora u datoteku.

4. Update text frame and exit - osvezava sadrzaj u tekst okviru prema
napravljenim izmenama u editoru i zatvara editor.

5. Exit without updating text frame - zatvara editor bez osveZavanja tekstualnog
okvira (izmene nece biti primenjene na tekstualni okvir).

6. Reload text from text frame - ucitava tekst iz oznac¢enog tekstualnog okvira u
editor (upotrebljivo za ucitavanje novog tekstualnog okvira u editor bez
gasenja editora koji je obradivao drugi tekst okvir).

7. Update text frame - obnavlja sadrzaj tekst okvira koji se edituje bez
zatvaranja editora.

8. Search/Replaced - standardni alat za pretrazivanje teksta i izmene delova
teksta.

Drugi alat omogucava korisniku da ucita sadrzaj TXT datoteke u editor. Ucitan
tekst na ovakav nacin je neformatiran. Korisnik mora naknadno da formatira
ovakav tekst.

6.3 Ubacivanje teksta uvozom iz spoljnih izvora

Ovaj nacin je pravi DTP (engl. Desktop Publishing) nacin koji podrazumeva da se
svi elementi publikacije uglavhom pripremaju u eksternim programima koji su
namenjeni za to. Tekst se, na primer, priprema u LibreOffice Writeru. U tom
tekst procesoru se tekst pise i formatira, a u Scribusu se samo uvozi i prelama.
Ovo omogucava autorima tekstova da slobodno rade bez potrebe da poznaju
Sribus. Omogucava, takode, da casopis koji radimo ima vise razlicitih autora.
Jedino je potrebno obezbediti da autori koriste jednaka formatiranja kako na
kraju ne bi svaki tekst bio razlicito formatiran, a to se moze postidi
standardizacijom i pravljenjem Sablona za LibreOffice Writer kojeg bi koristili svi
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autori. Nije LibreOffice jedini eksterni izvor koji moze da se uveze u Scribus, osim
ODT datoteka u Scribus moze da se uveze:

1. CSV - Comma Separated Values files

2. HTMLi HTM — HTML datoteke
3. PDB - Palm PDB Documents

4. SXW - Open Office Writer Documents

5. ODT - OpenDocument text Documents
6. TXT — Text Files (Uvoz tekstualnih datoteka sa filterima stilova)

Zajednicko za uvoz svih ovih formata je to sto pored samog teksta uvozimo i ve¢
uradeno formatiranje teksta. Pod uvezenim formatom se podrazumeva uvoz
stilova paragrafa, stilova karaktera, fFontovi i dekoracija teksta.

Moguca su neka manja odstupanja od originala, ali je to lakSe popraviti nego

Formatirati velike tekstove ispocetka.

Uvoz teksta iz eksternih izvora se izvodi desnim klikom na tekst okvir i izborom

e e v .

iskoristite precicu sa tastature CTRL+/. Otvorice se dijalog kao na slici 6.4.

Slika 6.4 Dijalog za uvoz teksta iz eksternih izvora

E Open

Look in: IE Computer

He o o alzgs

File name: |

Files of type: IOpenDocument Text Documents (*.odt)

=

Importer: IOpenOfﬁce.org Writer Documents E| I~ Import Text Only

Encoding: "
= 9 Comma Separated Value Files

HTML Files
OpenDocument Text Documents

OK Cancel

Palm PDB Documents
OpenOffice.org Writer Documents
Text Filters

Text Files

42

U pitanju je klasi¢an dijalog za
biranje datoteke za uvoz u
Scribus. Ono sSto je specifi¢no za
ovaj dijalog jeste padajuéi meni
Importer, kojim se bira

mehanizam (engine) za
prepoznavanje i uvoz stilova sa
tekstom. Pogresno izabran

mehanizam nece pravilno uvesti
stilove i tekst u Scribus.

Na ovaj nacin moguce je uvesti
tekst u Scribus bez Formata,
ukoliko nam nije potreban, vrlo
jednostavnim potvrdivanjem
polja Import text only.
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Ovo bi bilo skoro sve o uvozu teksta i formata u Scribus. U slede¢em poglavlju
¢emo se pozabaviti samim formatiranjem teksta.
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7 Formatiranje teksta

Dosli smo do kljuénog dela ovog tutorijala. Formatiranje teksta je
najkomplikovaniji i najvazniji deo DTP-a (stonog izdavastva). lako je ovo kljucni
deo, u internet dokumentaciji Scribusa nije bas idealno obradena ova oblast,
tako da smo vecinu znanja prikupili na osnovu iskustva; eksperimentisanjem i
imamo nameru, u ovom nastavku, da vam to iskustvo Sto bolje prenesemo.
Mozda ovo i nije najbolji nacin, ali sigurno daje rezultate. Cilj je da pokazemo
jedan od nacina kako ,,nauditi” Scribus da pravilno prepozna uvezeni tekst i da ga
na sto bolji nacin formatira, tako da nama preostanu, nakon uvoza teksta, samo
sitna doterivanja. Mnogo je varijacija i mogucénosti formatiranja teksta, pa
nemojte ocekivati da vam prenesemo sve.

Mi najvise koristimo uvoz HTML formata (iz wiki redakcije projekta) u Scribus, pa
¢e to biti okosnica ovog tutorijala, ali ¢emo i uporediti taj nac¢in sa uvozom ODT
tekstova iz LibreOffice Writera. Da¢emo razlike i prednosti jednog, odnosno
drugog nacina uvoza teksta, a sa osvrtom na automatsko formatiranje teksta.

Ako ste u meduvremenu pokusavali da primenite savete iz prethodnog
poglavlja, i da uvezete tekst i format iz nekog od spoljnjih izvora, verovatno
niste dobili idealne rezultate. Uvezeni tekst je bio po sadrzaju jednak kao i
original, ali Formatiranje je najverovatnije bilo ,niSta sa ni¢im”, ni priblizno
originalu.

»Niko se nije naucen rodio”, kaze stara poslovica, pa tako ni Scribus. Scribus
uvozi tekst i formate ali nije uvek siguran Sta i kako to da izvede i u Sta da
pretvori. Scribus ¢e prepoznati formate dcitavih paragrafa i takode formate
pojedinih reci. Formate paragrafa ¢e smestiti u svoje stilove, a formate reci ce,
kako najbolje zna, ,prevesti” direktno u svoj tekst. Pod formatima reci, najcesce
se podrazumeva dekoracija teksta (bold, italic, bold-italic, underline), ali i
promena fonta pojedine redi ili njeno bojenje drugom bojom.

7.1 Tekst uvezen iz HTML datoteke

Ako vam je redakcija ¢asopisa na internetu, onda je uvoz HTML datoteka logi¢an
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izbor. Odmah da kazemo da prevodenje HTML kbda nije idealno, ali je dovoljno
dobro da se dobije poluproizvod koji sa par klikova moze da se doradi kako bi se
dobili zadovoljavajudi rezultati.

7.1.1 Formatiranje reci unutar paragrafa

Prvo ¢emo se osvrnuti na Formate reci. Scribus bez problema prepoznaje tagove
b, strong, i, em, u. Kédove font, Scribus ignorise, bar mi joS nismo uspeli da
primetimo uslove koje menjaju ti kddovi, tako da treba voditi racuna koje HTML
kdédove koristimo. Kédove koje prepoznaje, Scribus pretvara u odgovarajudi
Format tih reci. Ako to ne uradi odmah po uvozu, to nije moguée naknadno
ispraviti, zato to moramo odmah podesiti po uvozu. Sve Sto Scribusu nije jasno
on pita (uglavhom) u toku uvoza. Ako se font koji se uvozi ne poklapa sa
podrazumevanim u nasem dokumentu, Scribus pita kojim da ga zameni. Isto
tako, ako font ne postoji uopste u izboru fontova, Scribus ¢e pitati kojim Fontom
da ga zameni.

Iz ovog se sada podrazumeva da morate prvo da definiSete koji je osnovni font.
Padaju¢i meni File » Documents Setup » Tools » Text Frame Properties. Na tom
mestu biramo osnovni font. Mi biramo FreeSans, 11 pt, black, text stroke black,
... (slika 7.1).

Slika 7.1 Text Frame Properties

¢ Document Setup -

- Tools
L
Document @ Text
@ .‘ Font: | Tr FreeSans Medium
Document D Size: 110 pt s
Information = [ —
|3 | Text Color: | Black 2 | shading: 100 %
GL‘I‘id‘eS |¢"] | Text stroke: |Black 2| shading: 100 %
l] ® | Fin color: | None : | Shading: 100 %
ispl: = | stroke color: N - | shading: 100 %
Display roke Color: | None 2 | shading: o
Tab Fill Character: None = Tab Width: 12.700 mm
b Fill Ch ‘ & b Width N
Typography Columns: 1 . Gap: 0.000 mm

Hyphenator

Fonts
Preflight
Verifier

| Defaults || Apply || OK || Cancel |
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Prilikom uvoza teksta u Scribus, otvori¢e se par dijaloga koji ¢e upitati kojim
fontom Zelimo da zamenimo iJtalic, bold, italic-bold i druge nepodrazumevane
fontove. Ako smo dobro odgovorili na sva pitanja, na kraju ¢emo dobiti dobro
formatiranje reci unutar uvezenog teksta. Ako smo pogresili i nismo uopste
definisali te Fontove, to moramo odmah popraviti. Idemo na padajuci meni File »
Documents Setup > Fonts kartica Font Supsitutionas (slika 7.2).

Slika 7.2 Font Subsitutionas

s Document Setup —

~ Fonts
o
Document Available Fonts | Font Substitutions | Additional Paths
@ Font Name Replacement
Document Bold | Freesans Bold A
Information N =
Bold Italic | Freesans BoldOblique &
L= Courier | FreeMono Medium &
Guides - - y
Italic | Freesans Oblique &
-]
=
Display
Typography

A

Tools

7

Hyphenator
55
iy
Fonts
Preflight Delete
Verifier

| Defaults || Apply || OK | | Cancel |

Date su vrste fontova i padajud¢i meni iz kojeg mozemo da izaberemo zZeljenu
zamenu.

Tek nakon ovoga mozemo ponovo uvesti tekst u Scribus i dobiti Zeljene
rezultate.

7.1.2 Formatiranje paragrafa

Nakon uvoza, osim standardnog formata paragrafa (slika 7.3), pojavice se i novi
stilovi (slika 7.4). PodeSavanje stilova se vrsi preko padaju¢eg menija Edit » Styles
ili jednostavno pritiskom F3. Otvori¢e se editor stilova kao na slikama 7.3 i 7.4.
Stilovi nekad budu bas onakvi kakvi nam trebaju, ali mnogo cesée im je
potrebno malo podesavanja, barem prvi put.
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Slika 7.3 Stil editor - podrazumevani stil

e« Style Manager

Name
-+ Name:

¥ Paragraph Styles
Default Paragraph S

¥ Character Styles
Default Character S|

V| 100.00 9

Slika 7.4 Stil editor - uvezeni HTML stilovi

e Style Manager

Name Name: |[HTML_h2
Line Styles
¥ Paragraph Styles

Default Paragraph § | Properties| Character Style

HTML_code d .
HTML_default (EEEE W | <)
HTML_h1 Distances and Alignment Optical Margins
HTML_h2 i+ |FixedLiis|[11.00pt; @ None
HTML_h3 JE— - =
HTML_h4 1 [ 20.00 pt Eales
HTML_li_level-0 ) Left Only
HTML p_ 19 | 10.00 pt -

P Right Only
HTML_pre HEEEE

Reset to Default

¥ Character Styles |

Default Character 5| | [ | Drop Caps

Advanced Settings
Min. Space W | 100.00 %

Glyph Extension

Min: [100.( _| Max: |100.

bulators and |

Position:

= | Wb,

~£ | 0.000 mm _| =+ 0.000 mm

Fill Char:

|100
1

New Clone |

-E | 0.000 mm
| Import || Delete |

| << Done |
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7 Formatiranje teksta

Editor stila ima 2 taba. Prvi tab je Properties ili, na srpskom, podesavanje
paragrafa, a drugi je Character Styleili stilovi karaktera.

Properties sadrzi podesavanja:

1. Distances and Aligment - Omogucava podesavanje proreda i udaljenosti
(razmak) izmedu paragrafa, ispred i iza paragrafa na koji se odnosi ovo
podesavanje i poravnanja paragrafa po marginama.

2. Optional Margins - Opcione margine su same po sebi jasne, to je podesavanje
poravnanja sa leve i desne strane u odnosu na opcione margine koje zadamo.

3. Drop Caps - Moguénost dodavanja vodeceg velikog naglasenog slova na
pocetku paragrafa (inicijal).

4. Advanced Settings - Napredna podesavanja omogucavaju da povecavamo ili
smanjimo razmak izmedu redii Sirinu i visinu karaktera na relativan nacin,
kako bi se Sto bolje uklopio paragraf u zadate margine.

5. Tabulators and Identation - Omogucava definisanje tabulatora i uvlacenja
paragrafa ili pocetnog reda paragrafa.

Character Style sadrzi podesavanja:

1. Basic Formatting - Omogucava podesavanje vrste osnovnog fonta paragrafa,
velic¢ine fonta, gustine fonta, veli¢ine razmaka izmedu karaktera i dekoracija
fonta.

2. Advance Formatting - Omogucava podesavanje Sirine i visine karaktera,
njegovog odstupanja od bazne linije i jezika teksta.

3. Colors— Omogucava podesavanje boje teksta i providnost.

Podesavanja ima sasvim dovoljno da se postignu svi potrebni efekti i da se tekst
idealno uklopi u dizajn.

Kada podesimo stilove iscrpeli smo sve moguénosti automatskog formatiranja
uvezenog teksta. Sva ostala podesavanja moramo da uradimo ru¢no kroz Edit
Text.

7.2 Tekst za kalibraciju

Da bismo bili sigurni da smo sva osnovna podesavanja uradili kako treba,
iskoristite tekst za kalibraciju koji smo mi pripremili:

Kalibracija.html

Kada ovaj tekst uvezete u Scribus, trebali biste dobiti slededi izlaz.
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7.2.1 Primer kalibrisanog teksta

Ako ne dobijete, trebate ponovo da podesavate stilove ili Fonts Substitution.
Dokument za kalibraciju Scribusa

Podesavanje stilova i dekoracija teksta

Podesavanje stilova

Obican paragraf sa dekorisanim tekstom: bold, bold-italik, italik, podvuceni, drugi
font i obojeni tekst.

Neideksirana lista:
- prvi

- drugi

- tredi

Indeksirana lista:
1. prvi

2.drugi
3. treci

Hiperlink: http://libre.lugons.org

Kod:

<div class="osam kol">
<h2><a href="#">/linkovi</a></h2>
<a href="http://linkl.tld">linkl</a>
<a href="http://link2.tld">link2</a>
<a href="http://1ink3.tld">link3</a>
<a href="http://link4.tld">link4</a>
</div>

<div class="osam kol" id="desno">
<h2><a href="#">/tekst</a></h2>
<p>ovde ide neki tekst.</p>

</div>

<div class="osam kol" id="desno">
<h2><a href="#">/drugi tekst</a></h2>
<p>ovde ide neki drugi tekst.</p>

</div>

Oktobar 2013. 49



7 Formatiranje teksta

Primeti¢ete da Scribus nije prepoznao tag za bojenje teksta i promenu fonta
unutar paragrafa. Ne znamo da li je problem u interpreteru HTML-a, ili nismo
upotrebili pravi tag razumljiv Scribusu, bilo kako bilo, tih podesavanja u HTML
uvozu nema.

Ako imate viSe takvog teksta, predlazemo da tekst onda uvozite iz ODT
datoteke koji nema tih problema. Pripremili smo i tekst za kalibraciju uvoza ODT
datoteke:

Kalibracija.odt
ODT je siromasan za paragraf stilove, ali zato fino uvozi fFormate reci.

Ili nema idealnog uvoza teksta iz spoljasnjih izvora ili mi nismo jos nasli idealno
reSenje. Ako nadete idealnije reSenje, molimo vas da nam javite pa da
dopunimo ovaj tutorijal.

7.3 Text Editor

U prethodnim poglavljima male Skole uvozili smo tekst iz HTML ili ODT
datoteka, korigovali uvezene formate (stilove) paragrafa, naucili Scribus koje
fontove da koristi za uvezeni tekst i sad nas uvezeni tekst ve¢ podseca na
original, ali ne u potpunosti, narocito tekst uvezen iz HTML datoteka odbija da u
startu primeni formate paragrafa koji je uvezao. Prakti¢no, citav tekst je
formatiran samo sa podrazumevanim (default) formatom paragrafa. Na nama je
sada da primenimo pravi format na svakom paragrafu, a pri tome treba da
pazimo da ne redefiniSemo formate koji su primenjeni na pojedine reci unutar
paragrafa.

Postoje dve vrste gresaka koje se mogu pojaviti u uvezenom tekstu:

1. Formati reci su primenjeni na pravim mestima u paragrafu ali Format
paragrafa nije.

2. Deo uvezenog formata paragrafa se primenio kao format reci a sam format
paragrafa nije primenjen.

U prvom slucaju, Zzelimo da zadrzimo format reci, tj., na primer, da italic reci u
paragrafu ostanu Jjtalic, bez obzira na ostatak teksta. Na ostatak teksta zelimo
da primenimo format paragrafa koji nije automatski primenjen. U drugom
sluc¢aju ne Zelimo da zadrzimo format reci koji je samo delimi¢no primenjen
format paragrafa. U tom drugom slucaju, redefinisaéemo primenjene formate
reci i umesto njih primeniti format paragrafa na citav paragraf.
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Sta je zapravo primenjeno, tj., koji su formati paragrafa primenjeni na uvezeni
tekst, najbolje se vidi u editoru teksta (CTRL+T, slika 7.5).

Slika 7.5 Text Editor

- Story Editor - Text73 - + %
File Edit Insert Settings

E Bv@o- &

| O Minion Pro Medium 3 [11.00 pt |7 T[100.00 % (|IT[100.00 % [}| [E)[EIEEIE] pefault Paragraph style 1 |

(it [ ) [ K [ oo Jsw JAA¥[ 0.00 2% [7] [l Black 108, o Black | 100%y

Default Paraaraph Stvle

|ayTop: flejan Marncs

Default Paraaraph Stvle

Y NpoLNMM HACTaBLUMMA3 Mane LWKONe YBO3MIW CMO TeKCT M3 HTML wam ODT patoTeka,
KOpWroBanu yseseHe ¢opmare (ctunose) naparpaca, Hayumnu Scribus koje poHToBE Aa KOpUCTH

HAPOYMTO TEKCT yBe3eH U3 HTML aatoTeka oabuja Aa y cTapTy npuMeHmn dopmate naparpada Koju
je yBesao. MpaKTUYHO YATAB TEKCT je GpopmaTipaH camo ca nogpasymesannm (default) dopmatom
naparpada. Ha Hama je cafia Aa NpUMeHWMo npasn GopMaT Ha cBakoM maparpady a npu Tome
Tpeba aa nasvumo aa He peaeduHNLEMO HOPMATE KOj| CY NPHMEHLEHM Ha NOjEANHE PEUm YHYTap

naparpada.
HTML h4 Text Editor
HTML default MocToje ABe BPCTE rpellaka Koje ce Mory NojasuTH y YBe3eHOM TeKCTy:
HTML ol 1. DOpMaTHh peun cy NpUMErbEHH Ha NPaBUM MECTUMa y naparpady anv ¢opmat naparpaga xuje,
HTML ol 2. [eo yse3seHor hopmMaTa naparpada ce NpMMeHNo Kao pOpMaT peun a caMm popmart naparpada

HWje NpUMEeHrbeH.

HTML default

Default Paragraph Stvle

¥ NpBOM C/yMajy XKeNrMMo fa 33APXKMMO GOPMaT PeyM, TO JecT, Ha NPUMEp A3 MTafMK Peyun y
naparpady ocTaHy uTaauk Ge3 ob63upa Ha oCTaTak TeKCTa. Ha OCTaTak TeKCTa XeNuMo [a
npUMeHHMO GopMaT naparpada Koju H1je ayToMaTCK1 NPMMEetheH. ¥ ApYroM ciyyajy He XenuMmo
13 33/|pXKUMO POPMAT Peyn KojM je Camo JeSIMMWYHO NpuMerbed GopmaT naparpada. ¥ Tom

Current Paragraph:
Words: 4

Totals:

Chars: 20 Paragraphs: 34 Words: 1094 Chars: 6907

33 yBe38HW TeKCT WM Caf Hall YBE3&HW TekCT sef nopceha Ha OPWrMHAN anu He y NoTNYHOCTH, || |

Pored svakog paragrafa, u levoj koloni editora navedeni su nazivi formata koji je
primenjen na tom paragrafu. Klikom na taj naziv otvara se izbor svih definisanih
formata paragrafa. Izbor formata na tom mestu primeni¢e format na celi
paragraf i redefinisace formate pojedinih reci. Na ovaj nacin se ispravlja druga
greska koju smo naveli prethodno, a ako zelimo da zadrzimo formate redi,

moramo da koristimo padajucu listu paragraf stilova iz linije alata (slika 7.6).

Slika 7.6 Padajudi i

zbor paragraf stilova

- Story Editor - Text74 -+
File Edit Insert Settings
No Style
= " ;
LEBvE & . . Beli bold
| o Minion Pro Medium & [11.00 pt 3 T[100.00 % ||IT[100.00 % |3 [EE[EIEIE) I |
< HTML_default

(| 5 ) 1« Jew [0 o JE¥| 0.00 %6 |7] (| Black 1009y m{Bla¢ yrm_h1 [

Default Paragraph Style AyTop: [lejaH Marnos HTML_h2

Default Paragraph Style Y MpOWAMM HacTaBUMMa Mane lWwKone ysosunu cmo | HTML_h3 aroTeka,
KOpWroBanm ysesete dopmare (cTunose) naparpada, Hayy HTML _h4 KOPHUCTH
33 YBE3EHW TEKCT M Cajl Haw yBeseHu TekcT Beh noacel yrm hs nyHocTy, ||
HapOYMTO TEKCT yBe3eH U3 HTML paToTeka onbuja Aa y cTa| HTML Ii level-0 ada koju
je yBe3ao. MPaKTUYHO YMTAB TEKCT je hOPMATHPaH camo ca - = )pMaToM
naparpada. Ha Hama je caja Aa NpUMEHWMO npasu Gopn HTML ol pH ToMe
Tpeba Aa NasMMo Aa He peAedmuHMWemMo dopmaTe koju cy| HTML_p A yHYTap
naparpada. HTML_pre

HTML h4 Text Editor separator

HTML default lMocroje ABe BPCTe rPellaka Koje Ce Mory NojaBnTH Y yBe3eHOM TEKCTY:

HTML ol 1. DopMaTti peun cy NPUMEbEHN Ha NPABMM MECTUMA y Naparpady anu Gpopmat naparpada Huje,

HTML ol 2. [leo yBeseHor dopmata naparpada ce NpUMeHNo Kao popmMaT peun a cam GpopmaT naparpada
HWje NprMeHbeH.
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7 Formatiranje teksta

Ako nam treba da definiSemo isti format paragrafa na vise uzastopnih
paragrafa, jednostavno treba oznaciti tekst tih paragrafa i izabrati format iz
padajuceg izbora formata paragrafa.

Napomena: Tekst editor nije tipa ,Sto vidis to ¢es i dobiti” pa se mora sa vremena na
vreme proveriti rezultat u tekst okviru van editora. Da ne biste izlazili iz editora,
samo primenite ucinjene promene na tekst okvir klikom na Update Text Frame u liniji
alata i proverite rezultat.

Problem nastaje ako nam treba da redefiniSemo format viSe paragrafa bez
c¢uvanja formata reci. Ovo nije lako uraditi u tekst editoru. Morali bismo jedan
po jedan paragraf redefinisati menjanjem Formata u levoj koloni. Mnogo je lakse
izaci iz tekst editora i na licu mesta, u tekst okviru, oznaciti tekst. Pomocu
Properties prozora u sekciji Text » Paragraph Style zameniti format Zeljenim na
tom mestu. Na istom mestu u Properties prozoru moguce je menjati i format
re¢i ako smo ga definisali, jednostavnim oznacavanjem reci i primenom
Character Style-a.

Ova dva nacina primene formata paragrafa u tekst editoru su jedine zbunjujucée
akcije za pocetnike u Scribusu. Svi ostali alati su jasni i rezultati njihovog
delovanja su ta¢no onakvi kakvim ih korisnik i oc¢ekuje. Zbog toga se vise ne
bismo zadrzavali na detaljnom objasnjavanju svih funkcija tekst editora.

Imamo jos jedan vazan posao u formatiranju teksta.

7.4 Hifenacija (prelom reci)

Ve¢ smo spominjali hifenaciju prilikom podesavanja na startu kreiranja
dokumenta. Rekli smo da postoji automatska hifenacija za srpski latini¢ni tekst
ako se podesi da je jezik Croatian. Medutim, ovo je prava prilika da upozorimo
korisnika da ova automatika nije bas gramaticki ispravna. U zadnje vreme, bez
obzira na to sto postoji ova latini¢na hifenacija, prelom reci radimo rucno.

Za prelom ¢emo koristiti Soft Hyphen (CTRL + SHIFT + -). Ovaj alat je idealan za
brzi ru¢ni prelom. Njegov rad ne zavisi ni od jezika ni od bilo kakve baze.
Dovoljno je znati gramaticka pravila, postaviti kursor na zeljeno mesto preloma
reci i pritisnuti kombinaciju tastera CTRL + SHIFT + —. Ostaje samo da se proveri
da li postoji dovoljno prostora za takav prelom reci. Ako postoji, prelama se reci
automatski se dodaje crtica. Dobra stvar je da se, ukoliko dode do naknadnih
promena u tekstu koje bi onemogudile ovakav prelom reci, re¢ vraéa u
prvobitno stanje bez crtice. Ovako se dobija veca kontrola ove funkcije, a ako se
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potkrade greska, krivi smo mi, a ne Scribus.

7.5 Dodavanje naslova

U nasem slucaju, glavni naslovi ¢lanaka su znatno vedi od ostatka teksta, osim
toga, tekst je u 2 kolone a mi ne Zelimo da nam se naslov lomi u kolone, zato su
naslovi u posebnom tekst okviru.

Da bismo dodali naslov, ne moramo skracivati osnovni tekst okvir sa ¢lankom.
Jednostavno nacrtamo novi tekst okvir preko postojeé¢eg u istom sloju (layer).
Otvorimo prozor Properties (F2) i u sekciji Shape kliknemo na Use Contour Line
unutar podsekcije Text Flow Around Frame. Ova akcija ¢e naterati tekst da se iz
osnovnog tekst okvira pomeri i vise ne zauzima prostor koji je sada namenjen za
tekst okvir naslova. Mi uvek koristimo konturnu liniju (Use Contour Line), mada
bi isti rezultat dobili i koris¢enjem Use Frame Shape (sklanja tekst sa podrucja
koje obuhvata naznaceni predefinisani oblik tekst okvira a on moze osim
pravougaonika da bude krug, elipsa, trougao, strelica i tako dalje) ili Use
Bounding Box (sklanja tekst sa podrucdja koji obuhvata pravougaonik koji
obuhvata predefinisani oblik tekst okvira, bez obzira da li je on pravougaonik,
krug, trougao, strelica i sl.). Konturna linija, ako se drugacije ne definiSe, prati
oblik osnovnog oblika tekst okvira, ali daje moguénost da se naknadno menja
po potrebi pomodcu Properties » Shape s Edit... i potvrdivanjem Edit Contour Line
unutar otvorenog prozora editora.

Ostaje nam posle toga samo da upisemo naslov, da ga uve¢amo i centriramo po
zelji. Sva ta formatiranja mozemo uraditi preko Properties prozora i njegove
sekcije Text.

Ovom prilikom skre¢emo paznju na podsekcije Columns & Text Distances i
Advanced Settings. Sa prvom podsekcijom mozZzemo vrlo precizno da
pozicioniramo tekst u tekst okviru (slika 7.7).
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~ Properties «]  Slika 7.7 Columns &Text Distances
XY, Z |
Shape |
Group | Druga podsekcija ¢e nam posluziti da fino i
Text | precizno podesimo svaki karakter, i
= ispiSemo nesto na neobican nacin, kao na
| Minion Pro v primer na3 logo LiBRE! ili logo LaTex-a,
Medium v bez pomoé¢i nekog drugog grafi¢kog
T [11.00 pt E programa.
= [Fixed Linespacing 1/ 11.00 pt |:l
> Color & Effects J = P—— "
> Style Settings | e
= First Line Offset J XY, Z |
\ Columns & Text Distances
. Shape |
Columns: [2 H
[Gap: 411 5.00 mm |:l Sl |
Top: 10.00 mm N Text |
Bottor Distance of text from top of frame ﬁ [Or Minion Pro N
Left: 10.00 mm B [Medium =
Right: 10.00 mm B T [ 11.00 pt :l
[ Tabulators... ] . . . 3
% [leed Linespacing + || 11.00 pt _l
»> Optical Margins
[ Advanced Settings J
image | A4 Adva‘nced Settings .'},,- -
dne | T [000% [JAY [000% |[I
colors | T [100.00% [2|IT [100.00 % ||
Word Tracking
Min:|100.00 % || Norm: |100.00 % ||
Glyph Extension
Min: [100.00 % |3 Max: [100.00 % ||
Image |
Line |
. . Colors
Slika 7.8 Advanced Settings = |
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v Properties
XY, Z
Shape
Group

Text

IG. Minion Pro

lMedium

P

T [11.00 pt

= [Fixed Linespacing :‘ 11.00 pt :|

EIEIEIEE

v Color & Effects

8| Black s
| Black M 100%y

Uyt | &) FIK )Lk oo lteSefA) N

M| 100 %)

Image
Line

Colors

Dodatnu dekoraciju teksta vrsimo iz
Properties » Text » Colour & Effects. Ova
podsekcija nam moze posluziti da
promenimo boju teksta, dodamo
podvlacenje teksta, precrtamo tekst ili
promenimo konturnu liniju ili senku.

Slika 7.9 Colour & Effects

Za kraj: Ovo bi bilo skoro sve sto se tice uredivanje teksta. Ostalo je jedino da
sami eksperimentisete, a mi se nadamo da ¢ete dodi do spektakularnih

rezultata.

Preostaje nam samo da dodamo okvire, tabele, ilustracije i na kraju da sve to
izvezemo u PDF odgovarajuceg kvaliteta, o cemu ¢e biti reci u narednim

poglavljima.
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8 Graficki elementi

8 Graficki elementi

U proslom poglavlju male skole zavrsili smo unos teksta i njegovo formatiranje.
Da bi nas PDF licio na casopis, nedostaju nam grafic¢ki elementi. Pod ovim
podrazumevamo:

1. Uvoz vektorske grafike (tabele i vektorske ilustracije).

2. Uvoz rasterske grafike (ilustracije u bilo kom rasterskom formatu).

3. Crtanje vektorskih elemenata direktno u Scribusu (predefinisani prosti oblici,
poligoni, tabele i linije).

Slika 8.1 Graficki elementi u Scribusu

D T T 7 16 U7 1 G UY T B 7 185 6 165 08 15 0 16 8 16 U158 165 931 T 1 8 1 69 88 15 B 1 9 S 15 e i T |

OE-BEB&E& 9%

o JE99 1220, (40, (339, 11129, (19 1300 90

VT OO0 0E

1 lpeTlCTﬂthaM

[Axmmja:

Axuuja Ubuntu /Io3e

syrop: Boraanosih Bojan

y«,uouasl»:rxd je jemna pemika
JMema capadma: YOyHTy Jlokam

Cpbuje je ycnoctanmma
Capajliby Ca PEHOMUPAHIM CRETCKOM
commarjon System 76

ystem 76 je mnoamarti npoussobay
syseTHO  KBanMTeTMMX  nanTon
heckron u cepsepexux patynapa, na
ojuMa_je moapasymemano mhcTad
fMpan YGYHTY oOmepaTHBHM crHcTeM
bixon pauymapu ce cknanajy ol
BPIHALMBO GMPAHIX KOMIOHEHTH 1
Matepujana xaxo Om  sajosommM
cTpoe KpuTepHjyue KnaTAreTs
eabemum oumrine mepopaarice
System 76 je  V6ywry Cpe6pii
tapriep 1 Viren [lnatunys mapr
fiep.

System

Mopen cmor mponspommor mopTdo-
1Ma, KoMIaHija System 76 crecpiE
fioapokana mpomonujy YoyuTy onepa-
fruBrOr cHCTeMa nMpeko mpojekara.
frames cryuajy, y nuraiy je 6ecnna
frHo  cnaibe  VOYHTY  Hamemmiital
Gynry Jlokania 3ajenimua Cpouje
fiaasit ce Ha AMCTH IUXOBMX MApTHE-|
a y oBoj akimju, Koja omoryhasa s

Cpouje u System 76

ba nmax u 6ps mawnn Gecrario
10bujere KpamrTeTHE MANEmHMUE Cal
GYHTY 3HAKOM, Kao It MAJC HwICHH-
11¢ 3a CyTlep TACTEpE Ha TACTATYPH.

power by

ubuntu

Buuie nupopmanuja o ooj axuuju, kao u|
HauHHY KaKo MoeTe oBHTH Gecrina|
THe HalenHiLle, MoskeTe Hahu Ha cnenchoj|
CTpaRMIM:
http://www.ubuntu-rs.org/akcija-ubuntu-
oze-stbije-i-system-7
a SBAHMNAH CINMCAK NAPTHEPA MoXeTel
IOEICRaTH HA CTAHMLUT KOMTaRIjC:
hittps://wwwsystem76.com/community/sti

Hapagno, Bmite o Kommanuju System|
76 moeTe nposHTaTh Ha maXOBO)
MaTHuHOj CTpaHH!
hitps://swwiw.system?76.com/

Autor: Petar Milojevié
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8.1 Uvoz vektorske grafike

Pocinjemo od vektorske grafike. Ovo je grafika koja je prirodna za Scribus. Sam
Scribus je program za 2D vektorsku grafiku pa zbog toga, bez mnogo problema,
prepoznaje obicni SVG, EPS, PS, ODG, SXD, SCE (od slobodnih formata). Sa malo
viSe problema prepoznaje i neke vlasnicke Formate A/, PICT, WMF.

Scribus prepoznaje i Inkscape SVG, ali nepotpuno za neke specificne /nkscape
elemente (blur, transparency, na primer). Ovo je jedan od problema u FLOSS
svetu. PreviSe Cesto se desava da programeri na pojedinim open source
projektima, u nastojanju da svom proizvodu obezbede sto vise Funkcionalnosti,
odstupaju od usvojenih standarda. /nkscape je na primer odstupio od opste
prihva¢enog SVG formata. Ovo je Inkscape-u donelo par novih moguénosti, ali
umanjuje njegovu saradnju sa Scribusom. Dizajner koji misli da objavljuje svoje
radove uradene u /nkscape-u ili ¢e morati da se odrekne tih nestandardnih
mogucénosti /nkscape-a, ili ¢e morati da ih izvozi u PNG i tek tako u rasterskom
obliku da objavljuje u Scribusu.

Vektorska grafika je nezamenljiva u slucajevima malih slika (suvise malo da bi u
rasterskom obliku bile dovoljno ostre), logotipa (moraju da budu precizni).

Druga upotreba vektorske grafike nema direktne veze sa grafikom; zapravo se
radi o tabelama. Tabele mogu da se crtaju direktno u Scribusu, ali je to vrlo
naporan posao. Naime, alat koji je namenjen za crtanje tabela zapravo pravi
potreban broj ¢elija koje su, u stvari, tekst okviri. Koliko ¢elija toliko tekst okvira
koje se ne mogu istovremeno obradivati. Lako se dogodi da se ti tekst okuviri
ispomeraju, i onda ta tabela izgleda mnogo neuredno. Zato je bolje tabelu crtati
u nekom drugom programu i na kraju je samo uvesti u Scribus kao vektor. Na
primer, nacrtate tabelu u LibreOffice Calcu, Stampate u PS datoteku, a zatim PS
datoteku uvezete u Scribus.

Za uvoz vektorske grafike u Scribus zaduzen je File > Import > Get Vector File....
Nakon odabira datoteke, potrebno je samo kliknuti na zeljenu poziciju na listu
gde Zelimo da se vektor pojavi. Ako se vektorski crtez sastoji od viSe elemenata,
oni ¢e biti grupisani u jednu sliku i pojavi¢e se u originalnoj velic¢ini. Na nama je
samo da ga selektujemo, i pomocu kontrolnih tacaka u uglovima slike da ga
smanjujemo, ili povecavamo po Zelji, i to bez gubitaka u kvalitetu.
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Slika 8.2 Vektorska sli¢ica sa kontrolnim tackama za promenu veli¢ine
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Naknadno, uvezeni vektor moze i da se ureduje. Potrebno je samo razgrupisati
elemente vektora (CTRL+SHIFT+G) i onda svaki element mozemo posebno da
uredujemo, kao na primer da izmenimo tekst u tabeli, mada to moze da bude
tezak zadatak ako je svako slovo pretvoreno u objekat, sto vektorski formati
vrlo cesto cine. Pretvaranje slova u objekat je obavezno za stampu, ali vrlo
nezgodno za naknadne ispravke. Prec¢icom (CTRL+G) se na kraju obrade ponovo
grupisu delovi vektora u jedinstvenu celinu.

Svi objekti u Scribusu se na jednak nacin uklapaju u ve¢ postavljeni tekst. Naime,
nije neophodno sklanjati tekst ispod nekog drugog objekta Scribusa, vektora,
okvira slike, prostih oblika, poligona ili nekog drugog tekst okvira. Dovoljno je
samo pozicionirati taj objekat i pomocu Properties prozora (F3) narediti da se
tekst pomeri ispod tog elementa na ve¢ objasnjen nacin u proslom poglavlju.
Tada smo pravili mesto za naslov (tj. za tekst okvir za naslov). To smo radili
pomocu podsekcije Shape, Properties prozora. Podsekcija Shape se koristi i za
sve ostale pojedinacne objekte u Scribusu, kao Sto su okvir slike, prosti oblici,
poligoni i sl. Kod grupisanih oblika za istu svrhu sluzi Group podsekcija.
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Slika 8.3 Group podsekcija Properties prozora i editovanje konturnih linija

Scribus 1.4.1.svn - [/media/Radni/Projekti/LiBRE! ¢asopis/10/LiBRE-10-cir.sla*]
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Podsec¢amo vas joS jednom da graficki elementi ne moraju da budu na istom
sloju (layer) kao i tekst. Ukoliko ilustracije treba da imaju fiksnu poziciju i ne
zavise od samog teksta, bolje je da budu na posebnom sloju koji mora biti iznad
sloja teksta, da bi uklanjanje teksta ispod ilustracija radilo. Posto u nasem
casopisu ilustracije zavise od teksta, mi praktikujemo da budu u istom sloju sa
tekstom. Tako je lakse tac¢no pozicionirati ilustracije bez prelaska u drugi sloj.

Napomena: U slucaju da su u istom sloju tekst i ilustracije, mora se paziti da se
nehoti¢no ne pomeri slika sa zadate pozicije. Da bi se obezbedila njena pozicija i
velicina, treba koristiti zakljucavanje. CTRL+L (Is Locked) obezbeduje
zakljucavanje pozicije, a CTRL+SHIFT+L (Size is Locked) zaklju¢ava dimenzije
ilustracije. Istim precicama na tastaturi se i otklju¢avaju objekti.
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8.2 Uvoz rasterske grafike

Da bi obezbedili da ovaj element ima vektorske osobine, Scribusovi dizajneri su
obezbedili kontejner za rasterske slike, bas kao Sto su to uradili sa tekstom. U
slucaju teksta, to je tekst okvir, a za uvoz rasterske grafike koristimo okvire za
slike (precica na tastaturi /ili odabirom /mage Frame sa linije alata). SmesStanjem
okvira na stranicu ¢uva se prostor za sliku koju Zelimo da uvezemo na isti nacin
na koji to cini tekst okvir sa tekstom.

Ilustraciju lako ubacujemo u kreirani okvir za sliku levim klikom na njega i
biranjem naredbe Get Image..., ili joS jednostavnije, sa CTRL+l. Nakon ove
naredbe otvorice se dijalog za izbor Zeljene datoteke ilustracije.

Napomena: Bez obzira da li je priprema namenjena za internet stranicu, PDF
casopis ili za Stampanu verziju, treba voditi racuna o rezoluciji rasterske slike
koja se uvozi u Scribus. Rezolucija ili, drugim rec¢ima, gustina tacaka, veoma
utice na kvalitet ilustracija. llustracija cija gustina padne ispod 150 tacaka po
inc¢u (DP/) bice vidljivo zamucena (reckavih ivica). Zato treba birati ilustracije ¢iji
original ima dobru ostrinu i povecati mu gustinu tacaka na barem 300 DPI.
Prilikom promene velicine ilustracije u samom Scribusu, menjace se ta gustina
(smanjivanjem slike, raste DP/i obrnuto) i zato treba voditi racuna da prilikom
povecanja originala slike DPI ne padne ispod 150.

Izabrana rasterska slika se pojavljuje u okviru slike. Za njeno uredivanje je
zaduzena Properties podsekcija /mage. Ova podsekcija je zaduzena za
pozicioniranje i podesavanje veli¢ine rasterske grafike unutar okvira slike. Vrlo
je korisna i automatika koja je tu pridruzena koja obezbeduje popunjavanje
okvira slike (Scale to Frame Size). Kada se izabere ova moguénost, ilustracija se
skalira na maksimalnu mogucu veli¢inu odredenu okvirom slike. Dodatno moze
da se izabere ocuvanje proporcionalnosti originala slike po Sirini i visini, ili bez
ocuvanja te proporcionalnosti. Jednom kada odaberemo Scale to Frame Size,
mozemo rucno podesavati veli¢inu okvira, a to ¢e biti propra¢eno promenom
velicine slike u njemu.

Na isti nacin, pomoc¢u Shape podsekcije prozora Properties, napraviécemo mesta
u tekstu za uvezenu sliku. Kod slika je veoma korisno tu koristiti Use Contour
Line. Uredivanjem konturne linije mozete uokuviriti sliku tako da tekst prati taj
okvir, a ne pravougaoni okvir slike. Da podsetimo da se upravo u ovoj sekciji i
otvara dijalog za uredivanje konturne linije klikom na dugme Edit....
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Slika 8.4 Shape podsekcija Properties sa dugmetom Editi Round Corners
dijalogom za definisanje zaobljivanja uglova
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Okuvir slike, kao i svi ostali elementi, moZe se uredivati. Mogu se zaobliti uglovi
(Properties » Shape » Round Corners), moze se u potpunosti menjati oblik okvira
(Properties » Shape » Edit...), menjati mu osnovnu boju popune i okvirne linije
(Properties » Colors), menjati vrstu okvirne linije i debljinu (Properties s Line) i sl.

8.3 Crtanje vektorskih elemenata

Kao sto smo i rekli, Scribus je program za 2D vektorsku grafiku i moze se
direktno crtati u njemu. Daleko od toga da on ima moguénost crtanja kao
Inkscape, ali za nesto jednostavnije, kao Sto su blok dijagrami ili neSto sli¢no,
vrlo je upotrebljiv. Kao pomo¢ nudi galerije jednostavnih oblika (/nsert Shape),
galerije pravilnih poligona (/nsert Poligon) i alat za crtanje linija (/nsert Line).

Sve ranije osobine i nacini uredivanja ostalih Scribus objekata vaze i za
jednostavne oblike i poligone.

Mi najviSe koristimo ove elemente kao pozadine za tekst kako bismo istakli
neku napomenu ili terminalski tekst. Tako smo i moguénost crtanja iskoristili za
crtanje naslovne strane, pa je naslovna strana kombinacija tekst okvira, okvira
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slike i poligona. Osim rasterskih slika, svi ostali elementi su nacrtani direktno u
Scribusu.

Za kraj: Svi elementi u Scribusu funkcioniSu na jednak nacin. Jedni su

namenjeni za rezervisanje prostora za tekst, drugi opet za rezervisanje
prostora za rastersku grafiku, ali uvek funkcionisu isto i ureduju se jednako.
Cak je jednom okviru moguce u svakom trenutku promeniti namenu. Tekst
okvir moze da se pretvori u okvir slike ili poligon u tekst okvir i sve ostale
kombinacije. Za to je zaduzen /tem > Convert to iz padaju¢eg menija. Ovo
omogucava laku prepravku uradenog i mnogo razlicitih kombinacija da bi se
dobio Zeljeni rezultat.

Slika 8.5 Padajudi meni /tem i naredba Convert To

Scribus 1.4.1.svn - [/media/Radni/Projekti/LiBRE! casopis/10/LiBRE-10-cir.sla*]
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Sada je nas casopis ve¢ 95% spreman za izdavanje. Ostalo je samo da u njega
ukljuc¢imo malo interaktivnosti (unutrasnje i spoljasnje linkove) i da to sve lepo

spakujemo u PDF, ali o tome ¢emo u narednom poglavlju.
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9 Zavrsni radovi

Doslo je vreme da zavrSsavamo nas PDF internet ¢asopis. Za kraj ¢emo uraditi:

1. doda¢emo unutrasnje i spoljasnje veze (engl. link),
2.izvrsi¢cemo kontrolu boja,

3.izvrSi¢cemo kontrolu buduéeg PDF-a i

4. snimi¢emo PDF ¢asopisa.

9.1 Unutrasnje i spoljasnje veze

9.1.1 Sadrzaj

Svaki casopis ima svoj sadrzaj koji upucuje citaoce na c¢lanke i teme koje moze
da procita u tom broju. Mi sadrzaj radimo na kraju, kad sve clanke i ilustracije
lepo slozimo. Tek tada sa sigurnos¢u znamo koji je clanak na kojoj strani, pa je
lakSe napraviti sadrzaj.

Sadrzaj se pisSe kao i svi ostali ¢lanci. Ovom prilikom ¢emo vam otkriti samo
jedan trik koji je nama vrlo koristan.

Struktura jednog reda sadrzaja je naslov clanka + broj strane. Naslov ¢lanka
treba da bude poravnat sa levom ivicom tekst-okvira a broj strane treba da
bude sto blizi desnoj ivici tekst-okvira i takode, svi brojevi strana treba da budu
medusobno poravnati po vertikali. Najlaksi nacin da se ovo uradi je da se pise
Naslov+TAB+str.XX. Svaki novi red sadrzaja treba da bude novi paragraf ali sa
istim paragraf stilom u kojem je podeseno levo poravnanje. Kad zavrsimo
upisivanje svih redova sadrzaja, podesavamo poziciju tabulatora, sto ¢e nam
omoguditi da na kraju brojevi strana budu lepo poravnati.
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9.1.2 Unutrasnje veze

Slika 9.1 Unutrasnje veze
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Dobra funkcija sadrzaja je da moze Citaoca, jednim klikom, odmah prebaciti na
zeljeni ¢lanak, tj. na stranicu na kojoj se nalazi taj ¢lanak. To je funkcija koju PDF
omogucava. Kad ve¢ postoji, treba je i upotrebiti, a nije zahtevna za
podesavanje.

Napravicemo prvo pripremu. Doda¢emo novi sloj (layer) i nazvaéemo ga
Lunutrasnje veze”. Od osobina sloja, osim ve¢ podrazumevanih, treba omoguditi
i Outline mode koji ¢e posebno da istakne (okvirnom bojom) podrudje osetljivo
na klik misa. Outline mode ne prepoznaje da li je element u tom sloju veza (link),
okvir za sliku ili tekst. On ¢e svaki element uokviriti bojom sloja, ali posSto ¢emo
mi koristiti taj sloj samo za veze, one ¢e biti lepo obeleZzene. Bez ovog dodatnog
obelezavanja veze bi bile neupadljive i ne bismo ih dobro kontrolisali.

Slika 9.2 Prozor Layer - Outline mode

Blend Mude:| Normal C|Dpacity: 100 % l

o B O = ﬁ[{h Name
N [ ] ‘Dutline Mode - Toggles the

'wireframe' display of

O objects to speed the
O ) display of very complex
objects.
] [ |Tekst

|5
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Moramo prvo da objasnimo princip rada veza (linkova) u PDF-u. Za razliku od
drugih programa koji mogu od teksta da naprave hipervezu (hiperlink), PDF to
ne moze. PDF tekst pretvara u objekat, tako da ako Zelimo vezu, moramo da
napravimo okvir oko nekog teksta i da njega proglasimo za hot spot (podrudje
osetljivo na klik miSem). NajceS¢e nam pravougaonik sasvim odgovara za tu
namenu (on je podrazumevan), ali moze da bude i krug, trougao ili bilo koji
drugi oblik koji se oblikuje u Scribusovom Shape editoru (Properties > Shape »
Edit...).

Da bismo nacrtali hot spot za vezu, koristicemo alat /nsert Link Annotation iz
linije alata. Pravougaonik se jednostavno razvlaci na zeljenom mestu. Po potrebi
se taj pravougaonik koriguje uz pomo¢ Edita i time je zavrSen prvi deo
definisanja veze. Drugi deo se sastoji u definisanju odredista na koje veza
ukazuje (vodi). Dijalog za odrediste veze se najjednostavnije dobija dvoklikom
na hot spot. Annotation Properties, kako se zove ovaj dijalog, daje moguénost
izbora tipa (7ype) veze:

1. Text (nije veza, ve¢ smo iskacuce tekstualno obavestenje),
2. Link (unutrasnja veza),

3. External Link (spoljasnja veza) i

4. External Web Link (veza sa internet lokacijom).

Slika 9.3 Prozor Annotation Properties - Link (unutrasnja veza)

Annpl-:.l-i Aan Deranartias
Text

Link

External Link
External Web-Link

[<]>] [¢]2]

| QK || Cancel

Posto prvo pravimo unutrasnju vezu, ne¢emo menjati podrazumevani tip veze
(ostaje tip Link), a za odrediste ¢emo definisati stranicu na nasem PDF-u kao i
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tacnu poziciju na strani po Xi Y koordinatama od referentne tacke (0,0) koja se
nalazi u gornjem levom uglu te stranice. Ako nas zanima samo da bude
pozicionirana na zeljenoj strani, u polja X i Y upisujemo nulu (0). Potvrdom na
dugme OK definisali smo vezu. Sada u nasem budué¢em PDF-u, kada korisnik
dode na polje osetljivo na klik misa, promeni¢e mu se pokazivac (cursor) iz
strelice u ruku, i klikom ¢e otiéi na zeljenu lokaciju unutar tog PDF-a.

Slika 9.4 Prozor Annotation Properties - definisanje unutrasnje veze

Annotation Properties

Type: | External Web-Link c|

Destination

tps:ﬁwww.lugons.orgfl

[ QK ] | Cancel |

9.1.3 Spoljasnje veze
Scribus razlikuje dva tipa spoljasnjih veza:

1. External Link, koji vodi na neki drugi PDF dokument snimljen na racunaru
korisnika i

2. External Web Link, koji otvara navedenu web lokaciju u podrazumevanom
web pregledacu.

External Link je namenjen pravljenju slozenih PDF dokumentacija, kao sto je, na
primer, uvodna stranica na vise jezika koja sadrzi osnovne podatke o proizvodu,
proizvodacu i veze ka uputstvu za upotrebu na razlicitim jezicima. Na ovaj nacin,
¢italac ima mogucénost da se upozna sa proizvodom, a posle da nastavi sa
uputstvom na svom jeziku. Sledeé¢i put nema potrebe da otvara osnovni
dokument, nego odmah otvara knjizicu uputstva.
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Slika 9.5 Prozor Annotation Properties - definisanje web veze

Annotation Properties {

Type: | Link c|

Destination

Page: |P1
X-Pos |EI pt
Y-Pos: |595 pt

[ oK || Cancel |

[<l>] [€]2) [¢]>]

External Web Link najvise koristimo u nasem casopisu. On dopunjuje clanke
dodatnim informacijama o datoj temi koje se mogu nadéi na internetu. Vrlo je
korisno da postoji direktna veza, ako ve¢ postoji adresa internet lokacije koja
daje dodatne informacije. Spoljasnja veza se pravi na isti nac¢in kao i unutrasnja
veza, koris¢enjem alata /nsert Link Annotation. Ono Sto se razlikuje, jeste
definisanje odredista veze. U slucaju External Linka, treba izabrati taj tip iz
padajuce liste, Sto ¢e otvoriti dijalog za trazenje drugog PDF dokumenta na
tvrdom disku. Kad ga lociramo i potvrdimo, zavrsili smo operaciju definisanja
veze. Kod External Web Linka, izborom tog tipa, otvara se novi dijalog gde treba
samo upisati punu internet adresu veze (sa uvodom http:...) i sa OK zavrsiti
proceduru pravljenja veze.

9.2 Kontrola boja

Neko ¢e reci da je pricu o bojama u Scribusu trebalo ispricati na pocetku, a ne na
kraju serijala male sSkole, jer smo ih koristili sve vreme dizajniranja casopisa.
Bojili smo elemente na master stranama, tekst-okvire, tekst, proste
geometrijske oblike... Mozda su u pravuy, ali to vazi samo za one koji od pocetka
znaju Sta hoce da dobiju i koji mogu u glavi da zamisle krajnji proizvod. Za one
neodlucne, ovo je pravo vreme da bojom daju pecat svom proizvodu.

Jos na samom pocetku serijala, naveli smo da je u Scribusu sve moguce ispraviti
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naknadno, tako je i sa bojama. Kao pomo¢ dizajnerima, Scribus sa novim
dokumentom otvara i jednu osnovnu paletu RGB boja koju dizajner moze po
svojoj zelji da menja i dopunjava. Sama paleta se automatski dopunjava novim
nijansama svaki put kad uvezemo neki vektorski crtez iz spoljasnjeg izvora. Sad
je vreme da ovu paletu sredimo i prilagodimo boje izlaznom dokumentu. Izlazni
dokument je opsteprihvaéeni PDF koji treba da se prilagodi vrsti Stampe.
NajcesS¢e koris¢ene metode Stampe su sito Stampa, offset Stampa i sve
popularnija digitalna Stampa. Svaka od ovih metoda zahteva od dizajnera da joj
se prilagodi. Sito Stampa zahteva 3-4 diskretne boje u ¢itavom dokumentu,
offset zahteva CMYK paletu boja i mora da se pripazi da li se objekti uklapaju
jedan u drugi ili se stampaju jedan preko drugog (moze do¢i do ,probijanja”
pozadinske boje). Digitalna stampa zahteva samo CMYK Semu boja. Ukoliko ne
stampamo nas PDF, onda je najbolje da sve boje ostanu u RGB Semi boja.

Slika 9.6 Prozor Colors

Colors -

WA
; g ;0% | Import |
. ﬂ 3 | New |
WA S
B [ sBlack | Edit |
|! g gl:a?) | Duplicate |
B @ FfromGetText#000000 | Delete |
B [E <4 Registration -
[ M White |E.emove Unused|
[ B grey
| OK |
[ Cancel ‘

Sredivanje boja u dokumentu vrsimo preko uredivaca boja kojem se pristupa
preko padaju¢eg menija Edit » Colors... Prvo Sto treba uraditi je ukloniti sve
neiskoris¢ene nijanse klikom na dugme Remove Unused. Scribus ée ostaviti samo
nijanse koje se nalaze unutar dokumenta. Od sada pa nadalje, svako uredivanje
postojec¢ih boja ¢e se odraziti na izgled samog dokumenta. Boje se ureduju
oznacavanjem i izborom dugmeta Edit. Ako, recimo, zakljucite da bi oni delovi
koji su sada plavi u dokumentu bolje izgledali ako bi bili bordo, jednostavno
ovde izmenite tu plavu boju u bordo i to ¢e se primeniti na sve objekte u
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Scribusu koji su koristili tu boju. Ovo je drasti¢ni primer uredivanja boja. Cesée
¢e biti potrebno samo pretvaranje iz RGB u CMYK sSemu boja i obrnuto, bez
vidljive promene nijanse.

Uvezene boje sa vektorskim slikama ¢e jasno biti oznacene u uredivacu boja
svojim imenom, koji je vezan direktno sa uvezenim objektom. MozZe da se desi
da su to iste nijanse koje se ve¢ koriste u ostatku dokumenta. Da ne bismo imali
dve iste boje sa razlicitim imenom, mozemo ukloniti te duple boje
oznacavanjem i odabirom dugmeta Delete. Boja nece biti automatski uklonjena
zato Sto je primenjena u dokumentu. Dizajner ¢e dobiti obavestenje da se boja
koristi i bice mu ponuden spisak boja da zameni tu boju nekom drugom
postoje¢om bojom. Tako se mozemo resiti duplih nijansi boja.

Sa dizajnerske strane gledista, vrlo je bitno da boje koje koristimo budu
komplementarne i da se medusobno ne iskljucuju. Koris¢enje prevelikih
kontrasta ne prija oku. Scribus i tu mozZze da pomogne. U padaju¢em meniju
Extras > Color Wheel, Scribus nam daje predloge komplementarnih boja na
osnovu neke osnovne koju dizajner zada. Na taj nac¢in se mogu izabrati lepe
kombinacije boja koje ne smetaju oku posmatraca.

Slika 9.7 Prozor Color Wheel

CMYK‘ RGB | HSV | Document.

CEN—
EX—
G
K: 24 % -

Click the wheel to get the base color. Its color model depen

l

HSV: #166e2ae
Color Scheme Method Result Colors
Split Complementary c] M [ Base Color
[ B 1st split
Angle: 28 E W@ 2ndspie
W [ 3rd. Split
Preview: [ B 4th. split

Vision Defect Type:

Normal Vision

3]

CMYK 5% 94 % 87 % 24 % |#0ef0df3e

RGB 174 20 23 #aelal7
Lorem ipsum daolor sit am HSv 358 226 |174 #166e2ae
Merge l[ Replace ][ Cancel
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Ovim smo zavrsili nas ¢asopis sa dizajnerskog stanovista. Preostaje jos samo da
proverimo i da snimimo PDF. | tu postoji par trikova na koje treba obratiti
paznju.

9.3 Snimanje PDF-a

Dosli smo i do kraja nase male skole Scribusa 1.4. U proslom poglavlju smo
definitivno zavrsili dizajnerski deo, a za ovo poglavlje nam je ostalo samo da
nasem casopisu damo konacan oblik. Casopis ¢e biti deljen slobodno na
internetu. Za tu svrhu idealan format je PDF.

9.3.1 PDF (http://sr.wikipedia.org/wiki/Pdf)

Portable Document Format (skra¢eno PDF) je format zapisa dokumenata kojeg
je kreirala kompanija Adobe Systems 1993. godine. Koristi se za zapis
dvodimenzionalnih dokumenata nezavisno od uredaja i rezolucije Stampanja.

Svaki PDF sadrzi kompletan opis dokumenta, ukljucujudi slike, tekst, vektorsku
grafiku i rasterske slike, te moze sadrzati i Fontove potrebne za prikaz teksta. Za
prikaz PDF dokumenata potrebno je imati odgovaraju¢e programe na racunaru
koji su besplatni i mogu se nadi preko interneta.

PDF je format zasnovan na jeziku PostScript. Moze se prepoznati po tome Sto su
prva cetiri bajta uvek %PDF. Ime dokumenta (datoteke) obic¢no zavrsava sa .pdf.

Kompaktnost PDF formata garantuje dizajneru da ¢e korisnik imati identican
prikaz svih elemenata kao u originalnom dokumentu bez obzira na platformu
koju koristi (vrstu uredaja, operativni sistem itd.). To je razlog zbog kojeg se
ovaj format koristi i kao ulazni materijal za Stampanje, ali i kao gotov proizvod.
(prim. aut.).

9.3.2 Kontrola Scribus elemenata pre snimanja PDF-a

Pre snimanja PDF-a, Scribus ima svoju kontrolu svih elemenata dokumenta kako
bi predupredio da se neke ocigledne greske pojave u kona¢cnom dokumentu.

Scribus kontrolor proverava sledece greske:

1. Proverava da li u tekstovima fali neko slovo. Ovo ne znaci da Scribus
proverava gramatiku u tekstu ve¢ samo proverava da li izabrani font ima sve
znakove koji se zahtevaju u tekstu. Ako pronade da neki karakter fali,
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upozorice dizajnera.

. Proverava da li se svi elementi dokumenta (okviri za slike, graficki elementi,
tekst okviri, itd.) nalaze unutar margina stranica. Ukoliko neki element izlazi
van vidljivog podrudja stranice, dizajner ¢e biti upozoren.

. Proverava da li tekst ,curi” van tekst okvira. Nekad se desi da je tekst duzi od
raspolozivog prostora rezervisanog tekst okvirom. Ukoliko se to desi, taj
visak teksta se neée videti na konacnom dokumentu, i na to ¢e kontrolor
upozoriti dizajnera.

. Ako se koristi PDF verzija 1.3 koja ne podrzava transparentnost slika,
kontrolor ¢e upozoriti dizajnera na sve slike koje imaju transparentnost
(providnost) u sebi. U verzijama PDF 1.4 visim, transparentnost je podrzana
pa se ova greskai ne proverava.

. Proverava da li sve slike postoje u dokumentu. Slike u Scribusu se ne uvoze
vec su samo linkovane sa neke lokacije na racunaru. Moze se desiti da
dizajner promeni lokaciju slike i onda taj okvir slike ostane prazan jer Scribus
ne zna gde je slika premestena. Ako se to desi, dizajner ¢e biti upozoren da
nedostaje slika.

. Proverava rezoluciju slika. Da bi slike u kona¢nom dokumentu bile dovoljno
ostre i bez krzavih ivica, rezolucija slika treba da bude u nekim okvirima.
Podrazumevani raspon rezolucije koja se toleriSe u Scribusu je od 144 DPI
(tacaka po in¢u) do 2400 DPI. Ispod donje granice slika postaje mutna ili
krzava, a preko gornje granice se preopterecuje izlazni dokument i ne dobija
se na kvalitetu slike. Kada slike nisu u ovim granicama, dizajner ¢e biti
upozoren.

. Proverava da li je neka slika u G/F formatu. U sustini, nije pogresno da slika
bude u G/F formatu. Scribus je samo oprezan s obzirom na to da G/F moze da
bude i animiran. Animirani G/F ne bi bio dobro prikazan u kona¢nom
dokumentu pa na to upozorava Scribusov kontrolor.

Postoje joS neke provere koje su uglavhom u podrazumevanim podesavanjima
iskljucene, kao sto su:

1. Provera da li postoje veze (linkovi) u dokumentu. Ova provera ima smisla
samo ako se pravi PDF 1.3 koji ne podrzava veze.

2. Provera da li postoje slojevi (layeri) koji su oznaceni da se ne Stampaju. | ovo
je podrazumevano isklju¢eno jer se pretpostavlja da je dizajner namerno
iskljucio Stampanje tih slojeva.

3. Provera da li postoji kolizija u podesavanju slojeva u smislu da je sloj nevidljiv
a daje oznacen da se Stampa. Ova provera je isklju¢ena iz istog razloga kao i
prethodna.

PodeSavanje ovog kontrolora se moze izvrsiti u Document Setup > Preflight
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Verifier.

Slika 9.8 Podesavanje Preflight Verifiera

Document Setup -

Check image resolution

o) 2 Preflight Verifier

Document IPDF 1.4 | V‘
@ [ Ignore all errors

Document Automatic check befere printing or exporting

Information Check for missing glyphs
1 Check for items not on a page
Guides i Check for overflow in text frames
M-J [0 Check for used transparencies
Display Check for missing images

Typography Lowest allowed resolution 144 dpi H Highest allowed resolution 2400 dpi H
Q Check for placed PDF Files
Tools Check for GIF images
@ [ Check for PDF Annotations and Fields

Hyphenator [J Ignore non-printable Layers
ﬂ [] Check for Visible/Printable Mismatch in Layers
Fonts Add Profile || Remove Profile

| Verifier | |-
Defaults || Apply H oK H Cancel

Ovu proveru mozemo da obavimo u svakom trenutku obrade dokumenta
klikom na ikonicu Preflight Verifier u liniji alata.

9.3.3 Kreiranje PDF-a

Current Profile:

Items Problems
Layers
~ Master Pages
¥ Normal Left
¥ Normal Right
¥ Leva stranica
¥ Desna stranica
¥ Page 1
¥ Page 2
v Page 3
- A Page 4

[

Issue(s): 0

Image resolution above 2400
& Image158 currently 3600 x 3600 DPI

v A Page 5

Image resolution below 144 [

& 1magelss oy 120 x 120 DRI

~

@ M i D

Check again ‘
72

‘[gnure Ermrsl

Slika 9.9 Preflight Verifier

Sada je vreme da kliknemo na ikonicu Save as
PDF u liniji alata i da krenemo sa kreiranjem
naseg PDF dokumenta. Prvo Sto ce se desiti
jeste pokretanje vec objasnjenog Preflight
Verifiera (kontrolora). Ukoliko nema gresaka
koje kontrolor moze da uoci, odmah ce se
pojaviti prozor Save as PDF. Ukoliko ipak ima
gresaka, dobic¢ete prvo prozor Preflight
Verifier sa svim upozorenjima na greske. Ako
greske ne uticu na krajnji dokument, kao sto
su upozorenja na G/Fili na malo prekoracenje
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okvira rezolucije slika, ove greske mozemo da ignoriSemo klikom na dugme
Ignore Errors.

Nije preporucljivo ignorisati greske kontrolora, ali ako je dizajner siguran da ¢e
sve ispasti na kraju kako treba, lakse je ignorisati upozorenja na, na primer GI/F,
nego konvertovati u PNG i ponovo sve takve slike povezati sa Scribusom. Dok je
Preflight Verifier prozor otvoren mogu se ispraviti sve greske i na kraju ponovo
proveriti dokument klikom na Check Again. Posto se isprave sve greske mozemo
da kliknemo na Save as PDFi da nastavimo sa kreiranjem PDF-a.

9.3.3.1 Prozor Save as PDF

Slika 9.10 Prozor Save as PDF

Save as PDF -

Output to File:

[fhomeffog!DropboxILiBRE!!12fLiBRE—12—cir.pdf| H Change... |

[J Output one file for each page

General | Fonts | Extras =Viewer @ Security = Color Pre-Press

Export Range File Options

® All Pages Compatibility: | PDF 1.4 (Acrobat 5)
© Choose Pages

<

Binding: |Left Margin

£33

[J Generate Thumbnails

Rotation: | 0-° Save Linked Text Frames as PDF Articles

<»

|g| |§| O Include Bookmarks
L _ O Include Layers

Resolution for EPS Graphics: | 300 dpi %|

[0 Embed PDF & EPS files (EXPERIMENTAL)

[ Clip to Printer Margins

Compress Text and Vector Graphics

Image Compression Method

Compression Method: | Lossless - Zip

<

Compression Quality: |Minimum

Maximum Image Resolution: 230 dpi %|

£33

[ Save ” Cancel

Save as PDF je prilicno slozen. Sastoji se od 7 kartica:
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1. General - opste postavke PDF-3,

2. Fonts - pridruzivanje koris¢enih fontova PDF-u,

3. Extras - specijalni efekti,

4. Viewer - podesavanje pocetnih postavki PDF pregledaca,

5. Security - dodavanje enkripcije dokumentu, korisnickog imena i lozinke za
otvaranje zasticenog dokumenta,

6. Color- prilagodavanje procesuiranja boja prema kona¢nom izlaznom

dokumentu,

7. Pre-Press - dodavanje dodatnih kontrolnih markera potrebnih za Stampanje

dokumenta.

Za PDF namenjen ¢itanju na ekranima interesuju nas samo prve dve kartice.

9.3.3.2. Kartica Fonts

Slika 9.11 Save as PDF - Kartica Fonts

Save as PDF -

Output to File:

’fhomeffongropbofoiBRE!!lsziBRE—lZ—cir. pdf\

|| Change... |

Embedding

Available Fonts:

[J Output one file for each page

General | Fonts | Extras | Viewer

Tr FreeMono Bold
Or Minion Pro Bold
G
G
G

Minion Pro Bold Italic
Minion Pro Italic

Or Minion Pro Medium

@r Minion Pro Regular

Tr SF TransRobotics Oblique

Minion Pro Bold Condensed Italic

Security | Color | Pre-Press

Fonts to embed:

SF TransRobotics Oblique
FreeMono Bold
Embed all W || 4

Fonts to outline:

Minion Pro Bold

Minion Pro Bold Italic
Minion Pro Italic
Minion Pro Medium

Minion Pro Bold Condensed Italic

Qutline all

Save ” Cancel |
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U dokumentu mozZemo koristiti vrlo egzoti¢ne i nestandardne fontove. Ako
PDF-u ne bi pridruzili sve koris¢ene fontove, korisnik koji nema te fontove na
svom racunaru ne bi video dokument onako kako je on zamisljen, nego sa nekim
podrazumevanim fontom. Zato ovde moramo iz spiska dostupnih fontova da
pomocu strelice pridruzimo koris¢ene fontove PDF-u. Pridruzujemo i sve
varijante Fonta koje su koris¢ene (bold, italic, bold-italic, regular, itd.). Ako se ovo
ne uradi, konacni PDF bi mogao da ima mnogo gresaka, kao Sto su: pogresni
font, ,curenje” teksta iz tekst okvira, nepostojanje naglasenog teksta itd.

9.3.3.3 Kartica General

Slika 9.12 Save as PDF - Kartica General

Save as PDF

Output to File:

lfhomeffongropboxILiBRE!!lsziBRE—lz—cir.pdﬂ H Change... |

[ Output one file for each page

General | Fonts | Extras Viewer Security Color | Pre-Press

Export Range File Options

<>

@ All Pages Compatibility: | PDF 1.4 (Acrobat 5)
O Choose Pages

<2

Binding: |Leﬂ: Margin

[ Generate Thumbnails

Save Linked Text Frames as PDF Articles

L8]

Rotation:  [0°®
|g‘ |§‘ [ Include Bookmarks
T _ Include Layers

Resolution for EPS Graphics: | 300 dpi %|

Ovo je osnovna i najbitnija kartica za kreiranje PDF-a. Naravno da ¢emo prvo
popuniti Output to File polje. Klikom na dugme Change otvara se klasi¢ni Save as
dijalog u kojem ¢emo na¢i mesto na racunaru gde ¢emo snimiti nas PDF i
da¢emo mu ime.

[ Clip to Printer Margins

Export range podrucje ne¢emo dirati jer imamo nameru da sve stranice snimimo
kao PDF. Sa druge strane, ako ho¢emo samo jedan clanak da izdvojimo, onda tu
treba zadati od koje do koje stranice ¢e biti podrucje snimanja PDF-a.

File Options sluzi da odredimo verziju PDF-a koju ¢emo koristiti za izlazni
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dokument. PDF verzija 1.4 je prva koja ima sve potrebne efekte za jedan
casopis. Podrzava providnost, veze, kompatibilna je sa starijim PDF citac¢ima itd.
Zbog svega ovoga mi koristimo upravo ovu verziju PDF-a.

Ovde mozemo jos$ cekiranjem da zahtevamo da se u napravljeni dokument
ugrade umanjene sli¢ice svake stranice (Generate Thumbnails) sSto moze da
pomogne kod navigacije. Ove slicice se automatski prave u vedini PDF
pregledaca tako da smatramo da ne treba zahtevati da to radi kreator PDF-a.

Obavezno cekiramo Save Linked Text Frames as PDF Articles Sto dodaje nase
linkove kao deo PDF-a.

Nismo pravili Bookmarks za lak$u navigaciju kroz duze PDF-ove tako da ga ne
ukljuc¢ujemo u PDF.

Resolution of EPS graphic drzimo na standardnih 300 DP/. Ova rezolucija se
odnosi samo na tekst i vektorsku grafiku. Rezolucija rasterske grafike se
podesava u sledecoj oblasti.

Zbog generisanja Sto manje PDF datoteke cekiramo Compress Text and Vector
Graphics.

9.3.3.4 Podesavanje velicine PDF datoteke

Od kompresije rasterske grafike u najvecoj meri zavisi velicina PDF datoteke.
Nas casopis ¢e biti distribuiran putem interneta. Velicina PDF datoteke je tu od
kljucne vaznosti. Da bi zadovoljili svaciji ukus pravimo dve vrste PDF-a.

Prva varijanta je sa najve¢om moguc¢om kompresijom rasterske grafike tako da
ukupna veli¢ina datoteke ne prede 5 [MB]. Ova verzija je za one koji imaju spor
internet ili ga placaju po protoku. Mana je sto su tako kompresovane ilustracije
prilicno lose, ali su i dalje upotrebljive.

Druga varijanta je sa boljom rezolucijom ilustracija, ali zato je datoteka mnogo
veca. Zbog interneta i brzine listanja casopisa ni ova verzija ne sme biti
prevelika. Mi smo postavili limit za ovu kvalitetniju verziju na maksimalno 23
[MB].

Za minimalni PDF koristimo Compression Method: Lossy — JPEG i maksimalnu
rezoluciju rasterske grafike od 150 DP/ Sa ovim metodom kompresije, sve
rasterske slicice se pretvaraju u JPG slike maksimalne rezolucije 150 DPI, Sto
daje malu PDF datoteku ali su slike slabog kvaliteta.

Compression Method: Lossless — ZIP koristimo za kvalitetnije izdanje ¢asopisa.
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Ova metoda koristi Z/P kompresiju za PDF a ilustracije ostaju u originalnom
formatu. Ovo daje bolji kvalitet ilustracija ali ve¢u datoteku. Fino podesavanje
veli¢cine PDF datoteka doradujemo smanjivanjem ili poveé¢avanjem maksimalne
rezolucije slika.

Ovo je sve sto je potrebno da bi se snimio PDF internet ¢asopisa. Ostalo je
samo da kliknemo na dugme Save.
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Pogovor

Ovom malom skolom obuhvacéen je samo deo moguénosti Scribusa. Nadamo se da je i
taj deo dovoljan kako bismo docarali Siroko polje njegovih moguénosti i kako bismo
vas inspirisali da dalje proucavate ovaj program.

Trudili smo se da se ne ponavljamo i da damo neka uputstva koja se ne mogu naci na
internetu. Nije nam bila namera da reSavamo dizajnerske probleme, nego samo cisto
tehnicke. Neka dizajnerska resenja su bila navedena samo kao primer kako se neki od
Scribus alata koriste.

Takode nam je bio cilj i da demistifikujemo citavu jednu oblast koriS¢enja racunara,
kao Sto je DTP (Desktop publishing — stono izdavastvo). Nadamo se da smo uspeli u
tome i da to viSe nele biti oblast koja je rezervisana samo za profesionalce. Dokazali
smo da i amateri mogu da se upuste u izdavanje svojih PDF: knjiga, maturskih i
diplomskih radova, brosura i ¢asopisa.

Ovo specijalno izdanje je kreirano kao priru¢nik. Namera nam je bila da vam ponudimo
izdanje koje u celosti obuhvata temu koja je u vidu serijala objavljena u 11 uzastopnih
redovnih izdanja casopisa. Ovim smo, nadamo se, olaksali pra¢enje ove teme i
savladavanje osnova rada u ovom programu. Bi¢e nam drago ako smo uspeli u tim
namerama i ako smo ovim specijalom uspeli da obogatimo vasu licnu PDF biblioteku.

Ako ovo izdanje bude dobilo vasu pozitivhu ocenu, mozete i u buduénosti ocekivati jos
ovakvih specijalnih LiBRE! izdanja.

LiBRE! tim
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Prilozi

Prilog A: Tabela 2.1
Prilog B: Index
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Prilog A: Tabela 2.1

Kategorija File Edit Item Insert Page
New Undo Duplicate Frames Insert
New from Template Redo Multiple Duplicate Insert Text Frame Inport
Open Item Action Mode Transform Insert Render Frame Delete
Open Recent Cut Delete Insert Table Copy
Close Copy Group Insert Shape Move
Save Paste Ungroup Insert Polygon Apply Master Page
Save As... Paste Recent Is Locked Insert Line Convert to Master |
Save as Template Contants Sizeis Locked Insert Bazier Curve Manage Guides
Revert to Save Select All Level Insert Freehand Line Manage Page Prop
Cillect for Output Advanced Select All Send to Layer Sticky Tools Snap to Grid
Import Deselect All Send to Scrapbook Glyph Snap to Guides
Export Search/Replace Send to Patterns Character
Document Setup Edit Text Adjust FrametoImage |Quote
o Preferences Edit Image Adjust Image tu Frame  |Spaces & Breaks
Print Preview Edit Source Update Image Ligature
Quit Colors Image Effects Sample Text
Extended Image
Replace Colors Properties Barcode
Patterns Preview Settings
Styles Attributes
Master Pages PDF Options
JavaScripts Convert To
Link Text Frames
Unlink Text Frames
Attach Text to Path
Detach Text from Path
Combine Polygons
Path Tools
Stand ardna kategorijasa
alatima za manipujalcijui Alati za editovanje i Alati za kreiranje i
podesavanje Standardna kategorijaza |podeSavanje elemenata |Alati za ubacivanje novih | manipulaciju stranis
dokumenata editovanje dokumenta |dokumenta elemenataudokument |dokumenta
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View Extras Script Windows Help
Fit to Height Manage Images Scribus Scripts Cascade Scribus Manual
Fit to Width Hyphemate Text Exacute Script Tile Tooltips
50% Dehypernate Text Recent Scripts Properties Scribus Homepage
Generate Table of Scribus Online
75% Contents Show Console Outline Documentation
100% Color Wheel About Script Scrapbook Scribus Wiki
200% Font Preview Layers Online Tutorials
>age |400% Short Words Arrange Pages Check for Updates
Preview Mode Bookmarks About Scribus
orties [Show Margines Measurements About Plugins
Show Bleeds Action History About Qt
Show Frames Preflight Verifier
Show Layer Indicators Align and Distribute
Show Images Tools
Show Grid PDF Tools
Show Guides
Show Text Frame
Columns
Show Baseline Grid
Show Text Chain
Show Control Characters
Show Rulers
Rulers Relative to Page
Move/Resize Value
Indicator
Sve vezano za pomoc pri
Alati za podesavanje Alai za prolagodavanje i |radu sa Scribusom kao i
ama |izgleda i funkdja Dodatne funkcije Alatiza upravljanje otvaranje Scribus online dokumentadija i
glavnog radnog prozora |Scribusa prilagodenimskriptama |dodatnih prazora tutorijali
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Prilog B: Index
INDEX

A

Annotation Properties— postavke veza (dodatnih objasnjenja) u PDF-u (str. 64)
Annotation Properties » Text — iskacuce tekstualno objasnjenje (str. 65)
Annotation Properties » Link— unutrasnja veza (str. 65)

Annotation Properties » External Link— spoljasnja veza (str. 65)
Annotation Properties » External Web Link — spoljasnja veza sa internet
lokacijom (str. 65)

B
Bezier Curve — neprekidna vektorska linija (str. 27)
Cc

CMYK, engl. Cyan Magenta Yellow Key (Black) — kolorna sema sa osnovnim
bojama cyan magenta zuta crna (str. 17)

Colors - kontrola i uredivanje koris¢enih boja (str. 68)

Color Wheel - Scribus-ov predlog komplementarnih boja (str. 69)
Convert To- promene namene okvira (str. 62)

D

Document Setup — osnovna podesavanja dokumenta (str. 23)
Document Setup » Fonts— biranje fontova koji ¢e biti korisS¢eni u dokumentu
(str. 25)
Document Setup » Fonts s Font Supsitutions— kartica za izbor podrazumevanih
fontova (str. 46)
Document Setup » Hyphenator— podesavanje automatske hifenacije teksta
(str. 25)
Document Setup » Tools» Text Frame Properties— osnovne postavke tekst
okvira (str. 45)

DTP, engl. Desktop Publishing — stono izdavastvo (str. 8)

Slobodni softver za DTP — slobodni softver koji se koristi za stono izdavastvo
(str. 10)
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G

Get Vector File... — uvoz vektorske grafike (str. 57)
Guides— vodece pomocne linije (str. 29, 34)

|

Image frame — okvir za sliku (str. 60)
Image frame > Get image... — metod ubacivanja slike u okvir za sliku (str. 60)
Insert > Character > Page Number— umetanje broja stranice (str. 31)
Insert > Line— crtanje prave linije (str. 61)
Insert » Polygon - crtanje pravilnih poligona (str. 61)
Insert > Shape - crtanje jednostavnih oblika (str. 61)

L

Layer— providni sloj (str. 16, 35, 59)
Layer > Outline mode — dodatno isticanje okvira elemenata u layer-u (str. 64)

M

Master Page — $ablon stranice (str. 26)
Page » Apply Master Page... — primenjivanje Sablona stranice na postojecu
stranicu (str. 32)
Page » Convert to Master Page... — pretvaranje obicne stranice u Sablon
stranicu (str. 31)

N

New Document— prozor za otvaranje novog dokumenta (str. 19)
New Document > Open Existing Document— otvaranje postoje¢eg dokumenta
(str. 20)
New Document > Open Recent Document— otvaranje nedavno otvaranog
dokumenta (str. 20)
New Document > New From Template — otvaranje novog predefinisanog
dokumenta (str. 20)

P
Page - stranica (str. 21, 32)

Page » Manage Guides... — uredivanje vodecih pomoc¢nih linija (str. 35)
Page » Insert— dodavanje novih stranica (str. 32)
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PDF engl. Portable Document Format (str. 70)
Preflight Verifier— provera dokumenta u letu, pre kreiranja PDF-a (str. 72)
Save as PDF — postavke PDF-a (str. 73)
Save as PDF » Fonts— pridruzivanje fontova PDF-u (str.74)
Save as PDF > General- glavhe postavke PDF-a (str. 75)

Properties — glavni plivajuci prozor sa glavnim podesSavanjima svih elemenata
dokumenta (str. 28)
Properties » Shape » Edit... — uredivanje Scribus grafickih elemenata (str. 28,
61)
Properties » Shape » Round Corners— zaobljavanje uglova na oblicima (str. 61)
Properties » Shape » Text Flow Around Frame — podeSavanje ponasanja teksta
u odnosu na aktivni oblik/poligon (str. 53)
Properties » Text— uredivanje teksta (str. 30)
Properties » Text » Advanced Settings— napredne postavke teksta (str. 54)
Properties » Text» Colour & Effects— postavke naprednog dekorisanja i
bojenja teksta (str. 55)
Properties > Text» Columns > Columns & Text Distances— uredivanje polozaja
teksta u tekst okviru (str. 36)
Properties > Text» Paragraph Style— definisanje stila paragrafa (str. 52)

R

RGB engl. Red Green Blue — kolorna Sema zasnovana na osnovnim bojama
(crvena, zelenai plava) (str. 17)

S

Save as Template... — snimanje dokumenta kao Sablona (str. 37)
Scribus verzija 1.4 (str. 11)

Soft Hyphen—ruc¢ni prelom reci na kraju reda (str. 52)

Styles — uredivanje stilova (str. 46)

T

Text edit... — interni tekst editor (str. 39)
Style of current paragraph - stil tekuéeg paragrafa (str. 51)

Text frame — tekstualni okvir (str. 30)
Get Text... — metod uvoza teksta u tekst okvir (str. 42)
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w

WYSIWYG engl. What You See Is What You Get - Sta vidis to ¢e$ i da dobijes (str.
10,15)
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CryptoParty

CryptoParty je svetska serija AdHoc dogadaja
usmerenih na Sirenje informacija i znanja o
privatnosti, sigurnosti i alatima za kriptovanje.

STA?

Drugi crypto party bi¢e u fokusu mail servisa.
Objasni¢emo zasto je bitno koristiti mail kao
secure servis, kako podesiti mail da mozete da
primate i Saljete kriptovane poruke.

GDE? KADA?

Univerzitet u Novom Sadu

Fakultet tehnickih nauka - FTN

Trg Dositeja Obradovica 2

ucionica broj 208, drugi sprat
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